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Macs, OS X, and AppleMACUSER News and Analysis About 
Macs, OS X, and Apple

BY KIRK McELHEARN

The Mac App Store needs 
to support software demos 
and upgrades

6

http://www.softgozar.com


L
ongtime Mac users remember how software was distrib-
uted before the introduction of the Mac App Store five 
years ago. You could buy boxed software in retail stores, 
and you could download shareware that you could try out 

and pay for if you liked. There was also freeware that developers 
gave away. Some developers still practice the shareware model, 
but the Mac App Store has become the sole provider for much of 
the software people use on their Macs.

This has its advantages: users are 

protected, since Apple validates the 

software; they don’t have to trust 

their credit card numbers to poten-

tially dodgy websites; and it’s easy to 

redownload apps and get updates, 

all through a single app that serves 

as a storefront. Developers pay 

Apple a 30 percent commission, but 

Apple manages fulfillment and billing, 

YOU CAN DOWNLOAD  

a demo of Fantastical, 

if you think to go 

to the developer’s 

website and look 

for it.
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and exposes their software to tens of 

millions of Mac users, so it’s not a 

bad deal.

But two things are missing from 

the Mac App Store: demo versions 

and paid upgrades. (This also applies 

to the iOS App Store, but I’ll just 

focus on the Mac in this article.) You 

can’t download an app to try it out for 

a week or a month, and then pay for 

it if it suits your needs. And you can’t 

get a discount on an upgrade to an 

app you bought a year or two ago, or 

even last week.

Both of these features are essen-

tial. Few users buy apps that cost 

$10, $20, or even $50 (or more) on 

the Mac App Store unless they’re 

sure those apps work exactly as they 

expect. I’ve downloaded many app 

demos only to find in the first minutes 

that the app isn’t for me. The Mac 

App Store could easily offer time-

limited demos so users can test them 

out. These demos don’t need to be 

long for most apps; a week is prob-

ably fine for basic apps, a month for 

apps with more complex features. 

Since the Mac App Store uses DRM, 

it would be trivial for Apple to 

develop a system whereby the apps 

stop working after a certain time.

Some developers do offer demos 

of their apps, but Apple won’t let 

them say so in their app descriptions 

on the Mac App Store. Users have to 

know that by checking an app’s web 

page they might find a demo.  

For example, Flexibits (flexibits.com/

fantastical) offers a 21-day demo of 

the calendar app Fantastical (See our 

review on page 34).

Some developers use a work-

around to provide demos: they sell a 

free app with in-app purchases. I find 

this confusing. If I later redownload 

an app, I may forget that I’ve bought 

these IAPs and which features they 

offer. I’d rather see the full price up 

front, and not be tricked by Free.

Upgrade pricing ensures that 

users remain faithful to an app; 

developers want to reward custom-

ers who have been using their 

calendar, text editor, or game, and to 

retain these customers over time. 

Upgrades also ensure that users are 

aware of new versions. When a 

developer releases a new version of 

an app, they can’t let existing users 

know there’s an upgrade via the Mac 

App Store. They have to name the 

upgrade differently: instead of 

MyApp having a new version number, 

the app’s name has to be MyApp 2. 

Some developers discount upgrades 

on launch (for a week or two, usually), 

which allows existing users to get a 

lower price, but also means that new 

MAC APP STORE

THE JOURNALING APP 

Day One currently has 

“upgrade” pricing on 

the Mac App Store.
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users get “upgrade” pricing. How-

ever, if an existing user misses the 

launch window, they have to later 

pay full price.

These features are essential to a 

healthy app ecosystem, and without 

them, both users and developers 

lose out. Users won’t take chances 

on new, unfamiliar apps, and devel-

opers can’t maintain a stable, long-

term user base. Third-party apps are 

one of the key elements of the Mac 

platform, and the more apps people 

buy, the more likely they are to stick 

with the Mac. Adding demo versions 

and upgrades would be beneficial for 

users, developers, and Apple.

Do you have any pet peeves  

that you think Apple needs to  

fix? Send your ideas to fixthis@

macworld.com. ■

9
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This tool can block 
ransomware on Mac  
OS X, for now
The RansomWhere? tool detects when ransomware programs 
start encrypting files and then blocks them.

BY LUCIAN CONSTANTIN

MACUSER
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A 
 security researcher has created a free security tool 
 that can detect attempts by ransomware programs to 
 encrypt files on users’ Macs and then block them 
 before they do a lot of damage.

Called RansomWhere? (go.macworld.

com/ransomwheretool), the applica-

tion is the creation of Patrick Wardle, 

director of research and development 

at security firm Synack. It’s meant to 

detect and block the encryption of 

files by untrusted processes.

The tool monitors users’ home 

directories and detects when 

encrypted files are rapidly created 

inside them—a telltale sign of ran-

somware activity.

When such activity is detected, 

RansomWhere? determines the 

process responsible and suspends it. 

To limit false positives—legitimate 

encryption programs being detected 

as ransomware—the tool whitelists all 

applications signed by Apple and 

most of those that already exist on 

the computer when RansomWhere? 

is first installed.

This means that in order to work 

as expected, the tool needs to be 

installed on computers that haven’t 

already been infected with ransom-

ware. The tool also won’t work if any 

ransomware programs that later 

infect the computer hijack or inject 

code into Apple-signed applications 

and use them to encrypt files.

When RansomWhere? suspends 

an encryption process, it prompts the 

user to allow the operation to 

continue or to terminate it. This 

provides users with an opportunity to 

whitelist legitimate encryption 

programs they know and trust.

While good at blocking opportu-

nistic ransomware attacks in general, 

RansomWhere? does not provide 

perfect protection, nor does it claim 

to have a 100 percent detection rate.

First of all, RansomWhere?’s 

blocking mechanism will only kick in 

after a ransomware program has 

encrypted a few files. Their number 

should be in the single digits, though.

“RansomWhere? was designed to 

generically stop OS X ransomware,” 

Wardle said in a blog post. “However 

THE TOOL MONITORS 
USERS’ HOME DIRECTORIES 
AND DETECTS WHEN 
ENCRYPTED FILES ARE 
RAPIDLY CREATED INSIDE 
THEM—A TELLTALE SIGN OF 
RANSOMWARE ACTIVITY.
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several design choices were con-

sciously made—to facilitate reliability, 

simplicity, and speed—that may 

impact its protection capabilities. 

First, it is important to understand 

that the protections afforded by any 

security tool, if specifically targeted, 

can be bypassed. That is to say, if a 

new piece of OS X ransomware was 

designed to specifically bypass 

RansomWhere? it would likely 

succeed.”

Until recently, ransomware cre-

ators have almost exclusively tar-

geted Windows computers, but that 

has started to change. There are 

already ransomware variants that 

infect Linux-based Web servers, and 

researchers have created proof-of-

concept ransomware programs for 

OS X to show the platform can be 

affected.

In February, malware researchers 

spotted a new ransomware program 

being sold on cybercriminal forums 

that had versions for both Windows 

and Mac OS. Then in March, Mac users 

were hit by KeRanger (go.macworld.

com/keranger), the first ever OS X 

ransomware found in the wild.

As the competition among ran-

somware creators intensifies, many 

of them will likely branch out to other 

platforms in search of new victims. 

Mac users are certainly an attractive 

target. ■

RANSOMWHERE? TOOLMACUSER

RANSOMWHERE? 

alert prompt.
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Apple should give customers free 
iCloud space to match their devices
The newly refreshed MacBook has fixed storage that tops out at 512GB. Some Mac 
laptops even start at 128GB! That just isn’t enough, and we think the answer is in the cloud.

BY SUSIE OCHS

MACUSER
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T
he new MacBooks (go.macworld.com/rosegoldmac 
book) announced in April aren’t very upgradeable: You 
can bump up the processor in either model to a 1.3GHz 
Intel Core m7 for a $150 upcharge, and they both come 

with 8GB of RAM. But you can’t upgrade the storage. The $1,299 
model has 256GB, and that’s all it will ever have. The $1,599 
model has 512GB, and that’s as high as it goes.

I love portable Macs, but I also have a 

lot of files, and managing them on my 

256GB MacBook Air is a chore. The 

biggest offender is my local Dropbox 

folder, which I use to back up my 

iPhone’s Camera Roll, but I also can’t 

keep a big iTunes library on this 

machine, or even local iTunes back-

ups of all of my iPhones and iPads. 

I’ve got two USB drives mounted 

whenever I’m at my desk: one for 

Time Machine, and one for just off-

loading device backups and big files.

My data-juggling act would get a lot 

easier with a terabyte of storage, but 

that’s hard to find in a Mac laptop. The 

13-inch MacBook Pro with Retina 

display only offers a storage upgrade 

for the most-expensive $1,799 model, 

which comes with 512GB of storage 

off the shelf but can go to 1TB for 

$500 more. (It’s worth mentioning that 

the entry-level 13-inch MacBook Pro 

only offers 128GB of storage for 

$1,299, the same price as the 12-inch 

MacBook with 256GB.)

Both models of 15-inch MacBook 

Pro with Retina display offer storage 

upgrades. The $1,999 model that 

comes with 256GB of storage can go 

to 512GB for $300 more or 1TB for 

$500 more. And a $500 1TB 

upgrade is also 

available for the 

$2,499 model. That 

means that Apple will 

sell you three Mac-

Book Pro configs with 

1TB of storage, 

starting at $2,299 for 

a 13-inch model, and 

$2,499 to $2,999 for 

the 15-inch model. 

None of those are in 

my price range—and 

like the 12-inch MacBook, the Mac-

Book Air has no terabyte option at 

all. But maybe there’s another way to 

get the storage I need.

iCLOUD TO THE RESCUE?

In the fall of 2014 (go.macworld.com/

fall2014pricecuts), Apple cut the 

prices on iCloud storage (go.mac 

world.com/icloudstoragepricing) to 

fall more in line with competitors like 

MY DATA-
JUGGLING ACT 
WOULD GET A 
LOT EASIER WITH 
A TERABYTE OF 
STORAGE, BUT 
THAT’S HARD TO 
FIND IN A MAC 
LAPTOP. 
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Amazon and Google. But the best 

thing Apple could do is recognize that 

we’re already paying a lot to play in its 

garden, and throw in free iCloud 

storage that matches the capacities of 

our Macs, iPads, and iPhones.

It wouldn’t have to be forever. Just 

start me off with a year or two and I’d 

probably keep paying for it when the 

time ran out. Apple made headlines 

(go.macworld.com/devicelifecycle)

recently for updating its environmen-

tal FAQ (apple.com/environment/

answers) with estimates of the typical 

“years of use” life span of its devices: 

The company “assumes” Macs and 

Apple TVs will be used for four years, 

and iPads, iPhones, and Apple 

Watches for three. Even rounding 

that down to two years for each new 

device would be sufficient, and Apple 

could even exclude the Apple Watch 

and Apple TV from the deal, since 

those don’t need associated iCloud 

storage nearly as much.

Yes, that would be a lot of free 

storage given away. People only pay 

for iCloud storage to use with their 

Apple devices, so if new Apple 

devices suddenly came with free 

iCloud storage…then who would pay 

for iCloud storage? Well, some 

people (maybe people with 16GB 

iPhones; go.macworld.com/16gbnot 

worthit) might use the free storage to 

back up the whole device, and then 

buy a little more to keep their photos 

and videos flowing to iCloud Photo 

Library without having to sync the 

iPhone to a Mac to offload photos 

that way. To facilitate this, Apple 

could make it easier to manage what 

files are kept where—say, by provid-

ing an “iCloud Locker” that only lived 

in the cloud and didn’t sync to your 

devices. That way you could offload 

files to the cloud, freeing up space 

on your devices but still having those 

files accessible on demand.

The Services portion of Apple’s 

business is growing (go.macworld.

com/apples2016q2), but it comprises 

a lot more than just iCloud storage 

fees. If millions of customers sud-

denly got more iCloud storage for 

free, it’s possible some other services 

would see an increase in revenue 

that would offset some of the lost 

opportunity. For example, you might 

FREE iCLOUD STORAGEMACUSER
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buy more apps or content to fill up 

your device, since you know that 

even when it’s stuffed to the gills 

you’ll be able to back up the whole 

thing to iCloud. Since the free iCloud 

storage would be cumulative, 

customers have more incentive to go 

all-in with the iPhone, Mac, and iPad, 

and the more Apple devices you 

own, the more likely you are to buy 

apps, purchase content from iTunes, 

subscribe to Apple Music, enroll in 

AppleCare+, and so on.

This certainly isn’t a brand-new 

idea (go.macworld.com/smarteri-

cloud), but consider me firmly on the 

bandwagon. Apple has tons of 

money, so giving away free iCloud 

storage when people buy a Mac, an 

iPad, or an iPhone probably wouldn’t 

send the company to the poor house. 

It would, however, suddenly make a 

256GB laptop or a 16GB iPhone or 

iPad seem a lot more valuable. ■
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Dropbox wants to stretch 
desktop file storage to infinity
A new demo shows the company’s vision of files that show up on your 
computer but don’t take up space.

BY BLAIR HANLEY FRANK

MACUSER
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D
ropbox has a futuristic vision for how its users will be 
able to share massive files and have quick access to 
them on their computers, without their hard drives 
overflowing.

The cloud storage company recently 

announced a new initiative at its 

Open conference in London called 

Project Infinite. It’s a push to create a 

new Dropbox interface that allows 

users to see all of the files they’ve 

stored in the cloud in their comput-

er’s file explorer without requiring 

them to keep local copies of each 

document, image, spreadsheet, or 

other file. 

With Project Infinite, users will be 

able to manage their files in the 

cloud by moving them around inside 

the Mac OS X Finder or Windows File 

Explorer, just like they would any 

local files that are taking up space on 

their hard drives.

Right now, Dropbox users who 

want to see the items they have 

stored in the 

company’s 

cloud among 

all their other 

files need to 

have those files downloaded to their 

Mac or PC—just like they did when 

Dropbox launched its product to the 

public seven and a half years ago.

Users can save storage space on 

their computers with a selective sync 

feature that only downloads some 

files, but the data people leave out 

can’t be seen on their computers at all. 

Project Infinite would take Drop-

box’s basic concept of creating 

folders that sync to the cloud and 

make it easier to work with an epic 

volume of files. It’s part of the 

company’s emphasis on helping 

users share files between one 

another, specially business users 

who pay for one of the company’s 

premium tiers. 

There’s still a lot the company 

hasn’t said about the new initiative. 

Dropbox won’t say when it plans  

to include Project Infinite in the 

publicly available version of its desk-

top applications, or even which 

customers it will be available to 

when it does 

launch. (It’s 

entirely 

possible that 

the compa-

ny’s millions of free users will be left 

out in the cold.)

Still, it’s a cool tech demo that 

could help convince more busi-

nesses to choose Dropbox when 

they’re considering a paid cloud 

http://www.softgozar.com
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storage service. The company is 

pushing hard for commercial adop-

tion and announced that it has more 

than four times the commercial 

customers now in Europe than it did 

two years ago.

The company also announced a 

new File Properties API that will allow 

people to apply custom metadata to 

files stored in Dropbox for use with 

third-party tools. That should help 

better enable applications like digital 

loss prevention services and data 

migration services. ■

DROPBOX DESKTOP STORAGEMACUSER
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MAC GEMS ARE APPS THAT OFFER 

STANDOUT UTILITY OR UNIQUE 

FEATURES AT A GREAT PRICE.

THE TEXTEXPANDER UTILITY (textexpander.com) saves keystrokes 

by letting you type a short sequence that’s replaced by a longer one. 

That’s the heart of the app, which has expanded (sorry) its repertoire 

of replacement types over time to include form letters with fill-in and 

drop-down elements, a library of emoji, and a host of placeholders 

for date, time, the contents of the clipboard, and other elements.

OS X UTILITY

TEXTEXPANDER 6: A SNIPPETS 

SUBSCRIPTION SERVICE THAT’S 

PRICED TOO HIGH
BY GLENN FLEISHMAN

TEXTEXPANDER 6

mm

PRICE WHEN RATED

$5 per month for LifeHacker 
plan; $10 per month for Team 
plan

COMPANY

Smile Software

The Latest Mac Products 

Reviewed & Rated
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The previous updates for OS X and iOS are less than a year old; we 

reviewed version 5 (go.macworld.com/textexpander5) of TextExpander 

for OS X last June, and our high opinion of the core software remains 

unchanged.

However, the reason for this new review is a significant change in how 

its maker, Smile, prices its new version, which is coupled with mandatory 

cloud-based synchronization through its own servers, as well as options 

to share continuously updated snippets for individual users and groups.

With the new ecosystem, the TextExpander apps for OS X and iOS 

(and a beta for Windows 7 and later) cost nothing but work only when 

there’s an active monthly or yearly subscription. Further, the company’s 

website becomes a required hub for all users, whether they sync and 

share or not.

For details about core features in TextExpander, consult our version 5 

review. In this review, I’ll point out changes in the snippet editor, but will 

be focused on the ecosystem of apps: First, how it all works; next, 

security decisions and trade-offs; and finally, how existing users should 

approach the new arrangement.

But I can start with the conclusion: This first iteration is overpriced for 

THE WEB APP manages 

sharing snippets, which are 

organized by type and use 

icons to identify additional 

characteristics, like globally 

shared.
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most users’ needs, and removing the ability to use TextExpander on a 

stand-alone basis with a less efficient personal sync doesn’t give exist-

ing customers any advantage. Smile says it plans to add additional 

features and sophistication, which may ultimately make it worth the price 

to some users in the future, including those upgrading from the previous 

stand-alone releases. But we review the software and service in front of 

us, not a future version we can’t test.

MOVING TO CLOUD CITY

The new set of TextExpander 

apps revolve around and 

connect to Smile’s servers. 

You’re required to set up an 

account and it has to be in 

good standing—currently paid 

for and active—to use snippets 

on any copy of the app you 

have, as well as to access 

sharing features on the web-

site. If you’re logged out or the 

subscription lapses, snippets 

disappear. (They can be exported from the OS X version to retain 

copies.)

The new app versions comprise TextExpander 6 for OS X, TextEx-

pander 4 for iOS, and TextExpander 1 for Windows (in beta). There’s no 

purchase cost for the apps. The two subscription levels are labeled Life 

Hacker (for consumers) at $5 billed monthly or $47.50 per year and 

Team (for businesses) at $10 billed monthly or $95.50 pear year. Smile 

offers a 30-day trial for both flavors of its service. (Owners of previous 

releases receive a lifetime discount on the Life Hacker tier’s yearly rate.)

Both tiers allow something previously unavailable in TextExpander: 

publishing snippets to others that push out updates whenever the 

source snippet is changed. Previously, TextExpander required exporting 

a snippet group (a folder that collects items), sending that or loading it 

on a shared local or cloud server, and importing it in another copy of the 

app. (That option remains available.) Further, anyone with permissions to 

edit a shared snippet can make changes, and those revisions are in turn 

REVIEWS | TEXTEXPANDERMACUSER

WHEN YOUR SUBSCRIPTION 

is inactive, TextExpander 

empties all the snippets.
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pushed to everyone that’s part of the shared group.

The Life Hacker flavor lets subscribers share with any other user by 

email address. The Team version adds administrator-level features for 

showing group members, managing permissions, automatically pushing 

groups of snippets to people joining an organization or already part of it, 

and consolidated billing.

This new ecosystem adds a slightly awkward web app to the mix. 

When logged into an account at Textexpander.com, you have the same 

access to groups of snippets and individual entries, and can even edit 

and add snippets using all the tools available in the native apps. (The 

website is also the only way to edit snippets with the current Windows 

beta, which lacks a front-end interface, and can only expand snippets 

defined elsewhere.)

Some snippet groups can’t be shared, and the iconography isn’t 

crystal clear. If you see an icon with a single person that also has an 

orange plus-sign icon to its right, you can add other users. The Sug-

gested Snippets group, however, can’t be shared, but has the single-

person icon. Groups identified with a globe are set to “worldwide” by 

Smile, such as for emoji.

TEXTEXPANDER NOW 

INCLUDES a Team tier for 

sharing snippets across an 

organization, managed via 

its web app.

PODCAST
Listen to our 

podcast about 

Text Expander 6 

(go.macworld.

com/textexpand-

er6podcast).
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Clicking the plus 

sign lets you enter 

email addresses, 

but not (yet at least) 

select people with 

whom you’ve 

already shared 

other snippets. 

There’s no global or 

local address book, 

which reduces 

utility, though 

ensures more 

privacy. You can set 

permissions for whether newly added people have admin privileges, can 

edit, or further share the group, or change the permissions at any time as 

an admin for anyone with whom you’re currently sharing.

Teams have more controls, with admins being able to assign snippet 

groups that are automatically added to new or existing users’ accounts. 

Team-shared snippets can be shared with guests outside the team, but a 

snippet group created for a team or moved under team management 

can’t be converted back to a regular group via the web interface. 

Instead, you have to export it and import it back in, then delete the team 

version.

Syncing and sharing are the same thing in this new ecosystem, and in 

my testing, it worked equally well on my devices with the same account 

and among devices logged in to different accounts that were sharing 

snippet groups.

The one significant change in the apps, by the way, involves both 

improvement and omission. A redesigned snippet editor has drop-down 

menus with all the special features, like inserting time-based placehold-

ers, system keys, fill-in items, and the rest. This is a far superior interface 

for both new and experienced users. The editor is identical across the 

Mac, iOS, and web apps.

However, there’s also a step back. TextExpander for OS X used to 

have a split-pane view that provided a live preview as you assembled a 

snippet. This preview now requires a keystroke (Command-Return), 
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A REFRESH SNIPPET editor is 

the same in web, iOS, and 

OS X apps, and is a nice 

bump up in being explicable 

to new and veteran users 

alike.
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which produces a modal dialog that has to be 

dismissed. In the iOS app, tapping a forward 

arrow brings up a preview and tapping a back 

arrow takes one back. The web app lacks a 

preview entirely.

And there’s an odd and unfortunate omis-

sion in this first outing related to sharing. You 

can’t manage shared snippet groups via the 

native apps. Sharing, adding people, managing 

permissions, and other tasks can only be done 

via the web app. While I expect that will be 

remedied in future releases of the apps, it 

makes it feel as if the ecosystem was released 

too soon.

The Windows client is still in beta testing, 

and didn’t work well for me on an up-to-date 

Windows 10 laptop; I couldn’t get it to expand with the latest beta 

release and restarting the laptop. It’s also “headless,” as noted, and has 

no snippet-editing or preferences interface.

HIDDEN IN PLAIN SIGHT

Previously, Smile hadn’t stored any snippet information on servers under 

its control. Any syncing involved required a third-party service, and 

snippets were as vulnerable to disclosure as the policies and protections 

offered by those other firms, like Dropbox and Apple (for iCloud).

Now, central storage of snippets is mandatory. The new ecosystem 

stores everything on Smile’s servers, uses the web app as a view into 

storage and administration, and treats apps as synchronized end points. 

This invites more scrutiny of Smile’s security and encryption. The com-

pany’s cofounder, Greg Scown, answered a number of questions via 

email that weren’t on the firm’s website as I wrote this, but the company 

plans to provide more detail.

Smile fundamentally maintains (go.macworld.com/textexpandersecu-

rity) that its users shouldn’t put anything that’s generally useful to 

another party if it were stolen, such as social security numbers and 

passwords. That’s impossible to enforce, of course, and snippets used 

inside a company—even the full set of responses a company uses for 

THE iOS APP (shown), web app, 

and OS X app show the same 

organization by how snippet 

groups are shared and owned. 

But sharing is managed 

exclusively at the Web site.
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customer service—could reveal 

sensitive information alone or 

when viewed as a set.

All the apps and the website 

use the most recent secure 

version of TLS (version 1.2) for 

encrypted sessions, such as over 

https. However, the apps and 

website don’t use certificate 

pinning, in which the digital 

certificates used to validate 

identity are restricted to be 

accepted only if issued by a small 

number of outside parties. 

Pinning prevents subverting 

operating systems through malware that can install root certificates that 

would produce valid-looking documents that a pinned app would reject, 

but a nonpinned one would accept. It’s seen by security experts as a 

best practice for iOS apps by Apple and for apps in general.

Scown says Smile stores snippets at rest in unencrypted form on 

database servers operated by Compose.io, an IBM company. The 

company evaluated using solutions in which data is always encrypted 

except during the moments items are needed for syncing or updating, 

and found the other security elements—such as how passwords were 

restricted—were lacking in its evaluation.

There’s a difference between unencrypted and insecure, and it’s not 

de facto unsafe that Smile has made this choice. An attacker has to 

defeat multiple lines of defense to obtain the raw data—like two-factor 

authentication—and the raw data in snippets isn’t likely to be as valuable 

(and thus it’s much less likely to be a target) as, say, information stored 

by a password-syncing company like AgileBits or LastPass. Data 

encrypted “at rest” is yet another bar an attacker has to pass, but it’s not 

insuperable, either.

However, I believe Smile’s approach is naive given the current secu-

rity climate. Other firms operating sync, backup, and hosting services 

that have native and web clients can let subscribers create a private 

passphrase that’s used for a per-account encryption key so that data is 
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always encrypted in storage. These systems 

can support various methods to allow shared 

access to the same resource, as well.

This may seem like overkill and it adds a 

support burden to Smile (a lost passphrase 

means snippets would be unavailable unless 

backed up locally), but with their subscription 

cost, this seems like a reasonable baseline for 

which to ask. There are many approaches, and 

Smile chose none of them.

One more issue: the terms of service (textexpander.com/terms) for 

TextExpander states explicitly, “The Service is not intended for use by 

users employed by any federal, state or local government.” This is likely 

intended to reduce liability, but it strikes another sour security note.

A CHOICE TO UPGRADE FOR EXISTING USERS

Those who own recent copies of TextExpander may be faced with a 

quandary. To ease the transition, Smile is offering registered users 50 

percent off monthly subscriptions for the first 12 months (about $2 a 

month), as well as a lifetime 50-percent discount off a yearly Life Hacker 

subscription, making it $20 a year.

However, many users may not be interested in the sharing feature; I 

can’t find a reason for it in my workflow. It’s my fundamental question as 

I review this revision: How many current users have been dying to share 

automatically updated snippets? The new system may be highly attrac-

tive to new subscribers, especially in business, but if you have no desire 

to move to this mode, you don’t have to.

The previous releases continue to work in iOS and OS X, and Smile 

will continue to offer them for sale under the old pricing ($45 for the OS 

X version and $5 for the iOS one). Smile also changed its original plan to 

just maintain compatibility for the older versions to continuing develop-

ment on them. In a statement on April 12, Smile said it will continue to 

bring some new features to the previous versions as well.

If you want to try out the new version, you can’t have both TextEx-

pander 5 and 6 running at the same time, although you can have both 

installed and named distinctly, and run one or the other. Installing the 

new version 4 in iOS doesn’t remove the previous version 3 release, and 

A REDESIGNED SNIPPET EDITOR 
HAS DROP-DOWN MENUS WITH 
ALL THE SPECIAL FEATURES, 
LIKE INSERTING TIME-BASED 
PLACEHOLDERS, SYSTEM KEYS,  
FILL-IN ITEMS, AND THE REST. 
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as alternative keyboards, you can switch among them.

Smile says TextExpander 6 won’t create backward-incompatible 

snippets, so you can make new snippets in the new version and then 

export and use them with the older one if you don’t choose to continue 

with a subscription.

You don’t have to make a decision right away. I believe most current 

users will probably stick with the previous versions.

A LOW VALUE IN THE CURRENT PRICE

As a dedicated user of TextExpander for many years, I continue to find a 

high degree of utility in it, even more so as it’s matured. However, it’s 

impossible for me to wholeheartedly recommend TextExpander’s new 

approach to either existing or new users.

For existing users, there’s not enough advantage unless you fall in 

what I think is a relatively narrow band of people who need more than 

sync and want individual or team sharing. If you’re one of them, this is 

the ecosystem for you.

For new users, the cost is simply too high for the current utility 

offered. While I trust that Smile will continue to expand and develop its 

product, the subscription price is not far below Slack’s paid tiers, and 

Slack is a vastly more complicated and sophisticated communication 

system. The business price isn’t far below entry-level customer relation-

ship management (CRM) software that includes form-based responses 

that are fully integrated with incoming and outgoing email.

A future version of the TextExpander ecosystem may fulfill Smile’s 

goals in making this business-model switch, but the current version falls 

short for the price demanded. ■
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ANKER USB-C 

DOCK

mmm
PRICE WHEN RATED

$60

COMPANY

Anker

USB-C DOCK

ANKER USB-C DOCK: THE RIGHT 
COMBO OF PORTS, BUT A USB 
POWER PROBLEM FOR DRIVES
BY GLENN FLEISHMAN

NO 12-INCH MacBook is an island; every portable of this line 

requires some kind of main connection. That’s at least a USB-C 

power adapter supplied by Apple, but more options have started to 

appear in the form of mini-hubs and full-fledged ones. I’ve been 

particularly waiting for affordable, portable alternatives to Apple’s 

$80 Digital AV Multiport Adapter (go.macworld.com/digitalavmulti-

port). The $60 Anker Premium USB-C Hub (go.macworld.com/

ankersuperspeedspec) with HDMI and Power Delivery fits the bill 

IMAGE COURTESY OF ANKER
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nicely with more ports, better flexibility, and a lower price.

The Anker hub has built-in pass-through power over USB-C, HDMI 

support up to the 4K resolution supported by a 12-inch MacBook (via 

DisplayPort 1.2/HDMI 1.4b), and two USB 3.0 Type-A ports. With a longer 

cord than Apple’s similar adapter, a brushed aluminum styling, and a 

better placement of ports, the Anker is my top choice for a 

portable hub to support an external monitor. (If you’re 

also, or instead, looking to use external drives 

routinely, pay special attention to the end of 

this review.)  

These compact hubs have full-fledged 

computers in them to handle all this conversion, but 

their job should be to not get in the way of data 

transfer. In testing, the Anker hub did just fine. With 

an external USB 3.0 drive (a bus-powered WD My 

Passport Ultra HDD 2TB), I got 90 MBps read and 

write rates through the hub’s USB 3.0 Type-A ports, just 

as fast as using Apple’s USB-C to Type-A adapter for a more direct 

connection. HDMI output worked as expected as well, providing a solid, 

stable signal.  

One odd note, however: I wasn’t able to get the MacBook to recog-

nize drives plugged into the Type-A ports initially; I had to reboot the 

Mac, at which point I had no further problems. That makes it seem like 

more of an OS X oddity than related to the dock, which requires no 

hardware drivers to work correctly.  

The Anker measures 4.7 x 1.6 x 0.4 inches, and I particularly like that 

the USB-C port for pass-through power is at the end of the longest 

dimension. Coupled with a 6-inch integral cord to plug into your Mac-

Book, this gives you a lot more flexibility in placement. It’s just 2.4 

ounces, making it a slight addition to your satchel or travel bag.  

Anker is admirably frank about the hub’s limitations, but, oddly, these 

limitations do not appear on its site nor in the product’s manual, but rather 

on the linked Amazon page (amazon.com/dp/B01AT27SKS) for the 

product. (Anker sells and ships its products via Amazon fulfillment.) These 

disclosures are far more extensive than any I’ve seen from other pass-

through power docks. For instance, the dongles for wireless keyboards 

that use 2.4GHz unlicensed spectrum (whether Bluetooth, Wi-Fi, or 

COURTESY OF ANKER
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proprietary) might not work, and Apple’s SuperDrive can’t be used.

The webpage also notes that Western Digital drives may not be 

supported and, sure enough, I saw some instability with keeping my 

model mounted, although I was able to run extensive suites of speed 

tests without a hitch as the only USB drive connected. If you own 

portable WD drives and prefer them, this would be a reason to not opt 

for the Anker dock.  

The page notes the maximum total current available for USB via the 

Type-A ports is 1500 milliamperes (mA) while the USB-C power adapter 

is connected to the hub, and 900mA without. This should be fine with 

most powered USB devices besides hard drives. The included manual 

only cites the 900mA limit without the connector, but provides a list of 

amperage draw by device type, which strangely excludes smartphones 

and tablets.  

This was troubling, so I tested in a variety of ways. I plugged in an 

iPhone 6s, which can draw anywhere from 500mA to nearly 2000mA 

(2A). With the iPhone attached, I had troubles copying large files with 

both the WD drive and a USB 3.0 flash drive from SanDisk. The drives 

spontaneously unmounted and remounted, which supports a power 

issue. With the iPhone unplugged, this problem went away.  

I didn’t read similar warnings nor did I have similar problems with the 

Satechi USB-C dock I tested recently, but it doesn’t include HDMI 

support, and there may be trade-offs in terms of power and circuitry, no 

matter what’s connected.  

BOTTOM LINE  

I can’t recommend the Anker as wholeheartedly as I’d like, because 

drive unmounting can result in lost data or drive issues, as well as being 

frustrating and a hassle. If you plan to attach unpowered drives routinely 

to a dock, this isn’t the right solution except in limited cases, potentially 

with just a single, non–Western Digital drive attached at a time. ■

http://www.softgozar.com


34

MACUSER

FANTASTICAL 2.2

mmmmh
PRICE WHEN RATED

$50

COMPANY

Flexibits

OS X UTILITY

FANTASTICAL 2.2 FOR OS X: 

MORE MATURITY AND 

INTEGRATION WITH EXCHANGE
BY GLENN FLEISHMAN

AS APPLE’S CALENDAR apps for iOS and 

Mac OS X moved across recent releases 

from inconsistent, inadequate, and irritat-

ing to more or less just fine, the market for 

replacements grew and matured. Fantasti-

cal for iOS (flexibits.com/fantastical), now 

in its second release, filled a gap there by 

not just presenting a clean list and having 

strong support for different calendar 

systems, but also offering natural-lan-

guage processing. Type in a semblance of 

an event, and Fantastical would parse it 

and place it for you without fuss.

Fantastical’s makers, Flexibits, brought a 

kind of snippet of Fantastical to OS X in its 

1.0 release: a drop-down day view closely 

reminiscent of the iOS version. Its 2.0 release in March 2015 was a 

full-fledged replacement for Apple’s Calendar and a strong competitor 

to similar products. The 1.0 view turned into the Mini-Window, an 

optional system menu-bar pop-down that gives a capsule view. A 2.1 

update later in the year answered many of our concerns in the initial 

release, but the just-released 2.2 update takes it much, much farther, 

making it a serious contender in Exchange-based offices.

The guiding philosophy for Fantastical 2 is that it’s a calendar app 

that focuses on upcoming events in a list view, keeping that view 

active no matter whether you’re looking at a graphical layout of day, 

week, month, or year. I live in the week view, and the combination of 

the upcoming list and a glance at the current week tends to work 

well together.
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The 2.1 and then 2.2 releases improved and 

extended ideas sketched out in the initial release, 

which prompted updated reviews for both ver-

sions. In 2.1, Fantastical interleaved reminders that 

have a date or date and time set in the graphical 

calendar view. While this can be disabled, it 

allows a more seamless flow of untimed remind-

ers, appointments, and to-do items that would 

seem to better fit how many people approach 

deadlines and completion.

With 2.2, Fantastical is a much more full-fledged 

part of the process of finding mutually agreeable 

times for meetings or events with other people, 

from seeing attendee availability to sending invitations to responding 

to invites. The user interface continues to deepen, with this release 

adding multi-event drag-and-drop, enhanced time-zone support for 

simultaneous display, and (finally) printing! The last was a notable 

omission that many readers clamored for.

Fantastical can pick up existing accounts and calendars set in the 

Accounts system preferences pain, or stored locally or via Exchange, 

as well as let you manually add other iCloud, Google, Yahoo, and 

Fruux accounts, or any CalDAV-compatible calendar link. This 2.2 

release has full, native Exchange support as well, allowing direct 

access for invitations, people’s availability status and lookup, and 

other features.

SPEAK FREELY

Flexibits has always stressed its natural-language aspect, and it works 

as well or better in OS X than in iOS. (I’ve used the iOS version for 

years.) You can typically type a narrative sentence like, Meet Laci at 

10:15 a.m. at 123 Every Street, New York, NY for two 

hours on Sunday and set an alarm an hour before, press 

return, and you’re done. The date is set by default to the current one 

selected in the calendar view; the address added to the location field; 

the end point figured out; and the alarm turned on.

This lets you include the kitchen sink when you make an appoint-

ment instead of needing to tap buttons and flip levers later, though 

TYPE IN SOMETHING that’s very 

nearly a descriptive sentence and 

Fantastical 2 parses out the event 

information.
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those options are 

available to modify as 

you want. You can also 

add entries in the 

drag-and-release 

model on the calendar 

layout, but even then 

Fantastical takes your 

mouse movements and 

fills in the parameters 

related to them and 

moves the text-entry 

focus to its fill-in field.

The supported 

vocabulary is quite 

large, though it’s easy to stump it. For instance, entering, eat bitter 

greens every night at 8 pm works just fine, but eat bitter 

greens at 8 p.m. nightly forever does not. Flexibits says it will 

be responsive to feedback and expand the vocabulary based on user 

requests. Starting in version 2.2, the app recognizes partial matches 

for place names, such as retail establishments, which reduces a step 

when you want an address attached.

Reminders have more limited parameters, 

and you can preface your to-do sentence with 

reminder or remind me to or the like. If in the 

process of creating a reminder or event, you 

can click a switch to flip to the other kind of 

entry. Version 2.2 also adds the ability to drag 

and drop the preview shown on the calendar 

based on your natural-language entry, which is 

a nice bit of additional flexibility.

As with most mature software, Fantastical rewards you for experi-

menting or becoming a more sophisticated user. While it appears at 

first glance that you have to choose a calendar from the pop-up entry 

rather than type it in, Flexibits hit the shortcut of using a slash fol-

lowed by the unique part of a calendar name and the appropriate 

one appears in the calendar field for the entry in progress. If you 

FANTASTICAL ORIENTS ITSELF 

around its event list view.

AS WITH MOST MATURE 
SOFTWARE, FANTASTICAL 
REWARDS YOU FOR 
EXPERIMENTING OR 
BECOMING A MORE 
SOPHISTICATED USER. 
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have calendars named Soccer, 

Office, and Shared Family, you 

only need to enter /So, /O, and 

/Sh to match uniquely.

Or you might notice that days 

and times are entered in a 

literal format when you drag-

and-drop, and thus enter the 

current date in full, like 

3/25/15, to create an all-day event.

WORK THE MOUSE AND KEYBOARD

An app that grew from an iOS sensibility definitely believes in mini-

mizing the number of “touches” with a mouse as well. This generally 

works to its advantage. For instance, in the year view—often a 

somewhat wasted view in other calendar programs that provides too 

much information and too little functionality—Fantastical uses shad-

ing to indicate the intensity of a day from yellow (least) to red (most). 

Hovering over a day for a moment reveals a floating summary; 

clicking a day scrolls the list at left to that day’s activities.

Clicking an event in the list sidebar or in the 

Mini-Calendar list or double-clicking an event in 

the weekly or monthly view brings up an edit-

able pop-over with the same options found 

when you initially create an event. This also 

appears when selecting an event in the day 

view, although in a separate right-hand pane.

In its drive to keep its approach clutter-free, 

options besides the basics are hidden while 

creating or when editing an event or reminder. 

Tapping a down-arrow or pressing Command-E reveals items, such as 

invitees, URL, and notes, as well as the time zone and repeat function 

in the default area if they haven’t already been set for an event. Given 

that I often need to enter notes, I wish there were an opt-in preference 

that allowed the drop-down options to open by default.

In version 2.0, navigating to a date on the graphical calendar layout 

and adding an event would end with a snap back to the current date. If 

VERSION 2.2 RECOGNIZES potential locations and offers autocomplete suggestions.

AN APP THAT GREW 
FROM AN iOS SENSIBILITY 
DEFINITELY BELIEVES IN 
MINIMIZING THE NUMBER 
OF ‘TOUCHES’ WITH A 
MOUSE AS WELL. 
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you needed to enter 

multiple events at that 

time or edit the details of 

what you just created, you 

had to navigate back. 

Fortunately, version 2.1 

added a preference that 

lets you opt whether or 

not to stay put after 

creation. That update also 

let you cut, copy, and paste events, allowing another method for 

interacting that fits in naturally. Version 2.2 extends this further: You 

can select multiple events to move and delete, handy when you’re 

trying to reshape a week’s worth of things at once.

For frequent travelers, Fantastical supports fixed and floating time 

zones for events: the former used for events occurring at a specific time 

in a given geographic area (an appointment or a flight) and the latter that 

should happen at the time of day (such as taking a medication) regard-

less of where you are. Enter a time zone in natural language or the word 

float or floating and Fantastical places it correctly.

Time zones are supported in reminders, but not floating times, and 

the time zone isn’t shown for reminders, though it is set correctly; the 

problem is with how Apple handles reminders, not Flexibits, however.

The current time zone is derived from the system, but can be overrid-

den in the Advanced preferences. I’ve 

found time-zone controls maddening 

in Apple and other apps; Fantastical 

has the best controls to set and 

events. It does lack a visual reminder 

in the list and datebook views that an 

appointment’s time is non-local, which 

I feel is overdue for fixing.

Even better in version 2.2, for 

those who are working with people 

across multiple time zones or who 

travel frequently, is a second axis 

time-zone scale that you can enable. 

REVIEWS  |  FANTASTICAL 2.2MACUSER

THE YEAR VIEW uses shading to 

indicate how busy a day is.

YOU CAN ADD a second time zone axis on 

the right, set to any zone in the world 

you want.

http://www.softgozar.com


39

In Advanced preferences, 

you can opt to show a 

second time zone, which 

appears in day and week 

views, using any zone you 

like. This doesn’t affect 

when events are shown, 

but lets you glance from 

right to left to see the time 

in that zone. Very clever.

Flexibits uses Calen-

dar Sets to manage which of your calendars appear. I’ve wound up 

with about 25 personal, family, hobby, and work calendars across 

seven accounts, and I typically don’t need to see all of them. Rather 

than constantly display a list of all calendars, active or otherwise, 

Fantastical offers a Calendars preference to build sets which you can 

select in a pop-up menu at the bottom of the list view. It goes further, 

too, by using geofencing to choose which set should appear when 

arriving or leaving at a set location.

Version 2.1 added a right-click option to duplicate a set, making it 

easier to have a model version that you modify, instead of rebuilding 

your selections from scratch for each new set. I definitely miss the 

ability to toggle one calendar on and off, but I used that feature so 

infrequently that I prefer having the screen space back for useful 

information I refer to all the time.

RSVP

Fantastical worked with Google’s calendaring system in previous 

releases of version 2, but 2.2 is the first that steps up to offer more 

robust support and for a broader array of systems and software for 

the whole process of finding attendees, checking their availability, 

inviting them, and managing responses. These improvements mean 

more people can take advantage of using the app as a hub for 

collecting people for an event without having to switch to other 

calendar software or web apps for some controls or options.

The biggest addition in version 2.2 is native support for Exchange. 

Previously, Exchange was handled slightly indirectly, giving the app 

A NEW FEATURE in 2.2 lets you 

see availability of invitees if the 

calendar server offers support.
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limited ability to 

interact with the 

server. Now, Flexibits 

says Fantastical lets 

its users respond to 

invitations, check 

someone’s current 

“presence” status 

(whether they’re free 

or busy), find people 

via an Exchange 

directory, and view 

categories. (I was 

unable to test these 

features as I’m not 

connected to any 

firms that use 

Exchange.)

More generally, Fantastical offers better interaction with iCloud, 

Google Apps, and regular Google accounts. While adding people to 

a Google Calendar event, Fantastical can suggest names from your 

Google contacts. iCloud notifications for shared calendars now 

appear. Google Hangout links work with Google Apps accounts, 

whereas before they worked only with regular Google accounts.  

And, depending on the remote server’s options, you can see when 

people are available to make appointments. Peering into availability 

is a feature long available in intranet software—I was using a package 

25 years ago that offered this. It’s nice to see it in a consumer-level 

product that can provide, in the right circumstances, enterprise-style 

interaction.

The latest version also lets you send event invitations and 

responses via Apple Mail or Airmail when a CalDAV server doesn’t 

have the hooks to handle it directly within Fantastical. That’s just 

another edge shaved down for people who have this server issue.

In the small-but-welcome department, holding down the Option 

key after showing the inbox for notifications and invitations now lets 

you click an OK All button, dismissing multiple messages in one go.

A PRINTING OPTION new to version 

2.2 has robust options for 

customizing and limiting.
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WATCHING THE DAYS DROP FROM THE WALL

Version 2.2 finally adds printing. That’s finally, without irony, as many 

people still like to have a hard-copy version of a schedule that they 

can annotate, give to others, or pin up on a bulletin board. The first 

pass at printing is comprehensive, as if it had matured alongside 

other features in the last year.

You can choose among the four views 

(day, week, month, and year) and a list, pick 

time periods and the number of said time 

periods to print, and even select your 

calendar set within the print dialog—that last 

nuance is rather nice for a new feature. You 

can also toggle the sorts of events (all-day 

and timed) and legends (calendar week 

numbers, tiny inset months) and color.

A change introduced in the last version 

continues to be useful months later. By 

interleaving reminders into graphical calen-

dar views, instead of making them a sepa-

rate display kind of thing, reminders fit much better in my workflow. 

While timed or untimed events that can be marked as completed are 

distinctly different from appointments at a given time for a specified 

duration, it’s incredibly useful to see reminders and appointments in 

one place.

Being able to disable that interleaving is nice as well, for those 

who prefer to keep reminders and appointments separate (go to 

Preferences → Appearance, and uncheck Show Reminders In Day, 

Week, And Month). Reminders can have no priority or three levels—

low, medium, and high—and be sorted by priority and due date, due 

date, or title. You can swap between viewing a list at the far left of 

events (including interleaved reminders) or just reminders, with 

Command-R or an icon click at lower left.

The previous update added an option to help with event over-

laps—View → Make Text Bigger/Smaller—which allows a good trade-

off between size, overlap, and legibility.

Two rough spots remain. For a program that has a lot of synchroni-

zation options for calendars, it lacks one important one: you can’t 

SINCE VERSION 2.1, Fantastical 

displays simultaneous events 

more clearly if you reduce the 

type size.
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sync account information or other settings, like Calendar Sets, 

between multiple computers running Fantastical (I have two), or 

shared feature settings between iOS and OS X. This means setting 

up Fantastical from scratch on each device and, when a change 

occurs, managing it on each device as well. The company opted to 

not use iCloud for syncing, as it offers the software in the Mac App 

Store and directly as well, but there are many other sync options for 

these kinds of configuration details.

The other rough spot is price. At $50, it’s a hard sell for any but the 

most dedicated Calendar haters or who have the right integration in 

a work environment that Fantastical can replace Microsoft, Apple, or 

other software. I don’t dislike Calendar, so much as find myself 

stymied by it. Having Fantastical on my iPhone led me to expect it on 

my Macs, too, and I gladly paid the price.

BOTTOM LINE

Fantastical’s overt simplicity and hidden depths may not be for every-

one. But Flexibits made distinct choices based on years of developing its 

iOS version and previous OS X release. Making design choices instead 

of throwing everything into the mix produces both good software and 

sharp contrasts—it’s less likely to be for everyone, but more likely to 

serve quite well those who find the choices appealing.

If you find Fantastical’s event-list centric approach—in which 

upcoming events can intermingle with reminders but remain dis-

tinct—matches the way you want to manage your calendar, and the 

natural-language entry an appealing way to add events without 

feeling like you’re adding events, it’s the right program to pick. ■
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PHOTOSHOP ELEMENTS 14: WHEN 

YOU NEED MORE THAN WHAT APPLE 

PHOTOS HAS TO OFFER
BY LESA SNIDER

LAST FALL, ADOBE released a new version of its consumer-level 

photo-organizing and -editing application, Photoshop Elements 14 

(adobe.com/products/photoshop-elements.html). A mature and 

uniquely user-friendly application, the latest version has a host of 

welcome improvements for beginners and advanced users alike.

For example, the Organizer has better facial recognition and it’s 

easy to find images that you haven’t yet organized with tags and 

events. The Editor sports an effects collection of 2,500 different 

looks; Guided edit mode has a new interface and two new tutorials 

for resizing images and simulating speed; plus the Enhance menu 

sports two new commands that fix both hazy and blurry photos. For 

beginners and hobbyist-level photographers, there’s very little here 

not to love.

ELEMENTS ORGANIZER

Organizer 14, the database portion of the application, is the most 

usable version yet. Built upon the concept of People, Places, and 

Events, you can use it to organize pictures into tidy stacks based on 

THE ENHANCE MENU sports two 

new commands that fix both 

hazy and blurry photos.
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who’s in them (People), where they were taken (Places), or what the 

occasion was (Events).

Version 14 includes several improvements, such as noticeably quicker 

and more accurate facial recognition, and the ability to easily round up 

images that don’t yet have people or place tags, making it easier for you 

to add them. For example, in People view, click Named to see image 

stacks that have facial tags and Unnamed to see those that don’t. In 

Places view, your choices are Pinned or Unpinned, with Pinned images 

appearing as stacks atop a nice big map.

While it’s easy to add locations to one or more images in Places view, 

the interface still feels very Windows-like in design: Once you click Add 

Location and enter some text in the resulting dialog box, you have to 

press the Return key to prod Google Maps into searching for matching 

results. Otherwise, you sit and stare at the dialog wondering why 

nothing is happening.

The Events view also got some organizational help and now has a 

Suggest button that groups related pictures together that you may want 

to use for a new event. Other Organizer improvements include a 

AS YOU ZOOM into the map, 

the pins split apart revealing 

additional image stacks. 

Click any stack to view it as a 

tiny slideshow.
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scrubby view in People and 

Places: point your cursor to an 

image stack and wiggle your 

mouse to see glimpses of the 

individual pictures inside. In 

People view, pointing your 

mouse at a stack also reveals 

buttons that let you pick what 

you want to see: only the 

person’s face or the entire 

photo (you can do this in Apple 

Photos, too).

ELEMENTS EDITOR

Additions to the Elements 14 

Editor are even more impres-

sive. New in the Effects panel 

of Quick edit mode is Smart 

Looks, which analyzes your 

image and reaches into a 

database of 2,500 effects to 

display the best five for that 

particular image.

Elements’ unique Guided 

edit mode also received a 

visual makeover and now 

illustrates each tutorial with an 

interactive “before and after” 

slider so you more fully under-

stand what you’re getting into 

before you start clicking.

There are a couple of new 

Guided edits, too, including 

one for resizing your photos for print or for the web, which is something 

that vexes some Photoshop CC users. Unfortunately, it doesn’t give you 

a resolution warning if you pick a print size larger than your pixel count 

can support, although Elements’ Print dialog box will. The other new 

SMART LOOKS ANALYZES your image to suggest five of 2,500 possible effects.

THE NEW FINAL panel in each Guided edit helps you decide what to do next.
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guided edit walks you through 

the otherwise complicated task 

of adding a motion blur to 

simulate speed.

Another nice addition to 

Guided mode is a panel that 

lets you decide what to do 

next: save the file, continue 

editing (if so, in which mode), 

or share your creation to 

Facebook, Flickr, Twitter, or the 

SmugMug Gallery.

As in previous releases, 

Elements 14 also snatched 

some powerful editing prow-

ess from other Adobe applica-

tions. For example, thanks to 

Camera Raw and Lightroom, 

the Enhance menu in Quick 

and Expert modes has a Haze 

Removal command that 

analyzes your image and 

removes any atmospheric haze 

it finds. This command is also 

available with a dialog box, 

which has a couple of sliders 

that let you take haze removal 

into your own hands.

And thanks to Photoshop 

CC, Elements 14’s new Shake 

Reduction command fixes 

blurry images caused by 

camera shake. The automatic 

version of this command analyzes your image from the center outward 

to find blurry areas from which it discerns a blur pattern—the direction in 

which your camera moved—and then corrects it.

Rounding out the changes in the Elements 14 Editor is the Refine 

THE HAZE REMOVAL command does a great job removing haze, even if it’s caused by a 

super volcano.

THE DIALOG BOX version of Shake Reduction lets you move and resize the area of 

analysis (marked by a dotted line), as well as add additional areas to be analyzed.
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Selection tool, useful for creating tough selections that involve hair or 

fur. To be fair, this tool isn’t new; it’s a more discoverable version of the 

Refine Radius Tool tucked inside the Refine Edge dialog box. Lastly, the 

Camera Raw plug-in that comes with Elements now supports newer 

cameras.

BOTTOM LINE

For those eager to expand their skill set beyond Apple Photos, Photo-

shop Elements 14 is a great choice—it’s the most user-friendly version 

yet and well worth the $100 price tag for a perpetual license—while you 

may find other image editors that cost less, they offer no organizational 

tools.

For those who own previous versions, it comes down to available 

cash. If you’ve got the money and you spend a fair amount of time in the 

application, you’ll appreciate the Organizer improvements, plus the 

Remove Haze and Camera Shake commands can salvage otherwise 

unusable photos. ■
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GRIFFIN BREAKSAFE  
BREAKAWAY POWER CABLE

Do you have a new USB-C MacBook, or are planning on buying 

one? You need this breakaway power cable. USB-C may be a 

versatile connector, but it’s not a breakaway connector, and it 

makes me miss the cleverness of Apple’s MagSafe connector on 

its MacBook Air and MacBook Pro laptops. Fortunately, there’s 

Griffin’s $40 BreakSafe Breakaway Power Cable (griffintechnology.

com). It brings breakaway power cable connectivity to the Mac-

Book and it could save your laptop from a mishap—like the time 

my dog tried to jump over my legs and tripped on my power 

cable. —ROMAN LOYOLA

48
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SUGR CUBE  
WIRELESS SPEAKER

The $229 Cube by Sugr (sugrsugr.com) 

is billed as the world’s first portable 

Wi-Fi speaker with Spotify. That may be 

the case, but I found the Cube to be 

much more than that. I found it to be a 

wireless speaker marrying form and 

function—one that doesn’t need a 

smartphone or app to satisfy your 

musical cravings. The diminutive Cube 

strikes a, ahem, sweet spot. It’s beautiful 

to look at, and its support for AirPlay, 

DLNA, and Spotify Connect streaming—

in addition to its own storage—are 

worthy of your attention. Marry that with 

its unique tactile elements and you have 

a small, versatile speaker that will satisfy 

many. —THEO NICOLAKIS
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POLAROID REMOTE- 
CONTROLLED PANORAMA  
EYEBALL HEAD

The $50 Polaroid Remote-Controlled Panorama 

Eyeball Head (polaroid.com) provides a pocket-

sized, remote-controlled 360-degree view for your 

smartphone or GoPro camera that can be used 

with any tripod. It’s a roughly three-inch black orb, 

and on the bottom you’ll find a quarter-inch 

threaded hole compatible with standard tripod 

heads; a bronze ring crowns the device with a 

male screw onto which a compatible camera is 

attached. The device is solid and well-constructed, 

with a micro-USB port for recharging the sealed 

450mAh battery in around eight hours; an indicator 

light on the internal circuit board turns red while 

charging, green when connected via Bluetooth, or 

blue when changing head direction. It works great 

for panoramic shots, so it’s worth a try for shutter-

bugs.  —J.R. BOOKWALTER
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NOVELS ROCK ‘N’ ROLL
STAND-UP COMEDY JAZZ
VIDEO GAMES MOVIES
COMIC BOOKS TALK RADIO

EVERY NEW ART FORM HAS ITS FIGHT FOR FREE SPEECH.

OUR TIME IS NOW

V I D E O G A M E V O T E R S . O R G

FIGHT FOR YOUR VIDEO GAMES

http://www.softgozar.com


52

iOS CENTRAL �e Latest on the iPhone, iPad, 
iPod Touch, and App Store

Hands-on: iOS 9.3, CarPlay, and the 
Chevy Volt are firing on all cylinders
The 2016 Chevy Volt has the best CarPlay screen we’ve tried yet, and the new additions 
to Maps and Apple Music in iOS 9.3 are most welcome, even if a little overdue.

BY SUSIE OCHS
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M
ore new cars are shipping with CarPlay every year, 
including the Chevy Volt. GM loaned us one to try 
the new features Apple just added to CarPlay in iOS 
9.3, namely the For You and New sections in Apple 

Music, and the ultra-handy Nearby feature in Maps.

In the video below, you can see both 

features in action, but what you can’t 

see is how much more responsive 

the Chevy Volt’s touchscreen is than 

the aftermarket CarPlay stereo from 

Pioneer (go.macworld.com/carplaypi-

oneeravic) that I tested a year and a 

half ago. That one had a capacative 

touchscreen that just didn’t register 

all of my touches, but the Volt’s 

built-in touchscreen worked perfectly 

every time.

iOS 9.3 brought the New and For 

You sections to Apple Music in 

CarPlay, which is great if you aren’t 

sure what you feel like listening to. I 

love how the New section has more 

than just albums, but I wish you could 

refresh For You to get more sugges-

tions, like you can on the phone. In 

Maps, the Nearby feature is great for 

finding coffee, gas, restaurants, and 

VIDEO

To view this  
video, go to go.
macworld.com/

carplayios93
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more—except sometimes it wants 

you to pull a U-turn and retrace your 

steps to a destination behind you, 

instead of finding you something in 

the direction you’re already headed.

2016 CHEVY VOLT

The Volt’s high-tech bells and 

whistles even had me wondering 

how the Apple Car would compare. 

For starters, the Volt is a plug-in 

hybrid, kind of the car version of 

Apple’s Fusion Drive.

The Fusion Drive, you’ll recall, 

combines a solid-state drive and a 

traditional hard drive into one 

volume, so you get both faster 

speeds and plenty of storage space. 

The OS handles all the heavy lifting 

of deciding what files and applica-

tions go on each drive, so it’s all 

seamless to the end user. The Chevy 

Volt has both a rechargeable battery 

and a gas tank, and the dashboard 

prominently shows how much range 

you have left on your battery, and 

how much further you can go before 

you’re out of gas. If you can keep the 

battery charged, you’ll barely use any 

gas at all, but on days you need 

more range, the car seamlessly starts 

using gas when the battery runs out. 

It’s automatic—you’re just cruising. I 

know all-electric is all the rage, but 

this seemed to me like a very Apple 

way to do things.

I was also impressed with how 

many sensors the Volt has. It could 

tell if I left the keys inside, and 

beeped to warn me. (The “key” is 

really just a 

fob, and to 

start the car 

you just need 

to have the 

fob nearby 

and press a 

glowing blue 

button on the 

dash.) The 

headlights 

came on 

automatically 

when it got 

dark. A 

dashboard 

indicator showed if I was following 

the car in front of me too closely, and 

little lights blinked on each side-view 

mirror if a car in the next lane was 

riding in my blind spot.

Maybe if your car is newer than my 

2006 Subaru wagon, these features 

won’t sound so futuristic to you. But 

something about having a partially 

electric car talking to me with Siri’s 

voice—complete with an iOS app (go.

macworld.com/iosonstar) for locking, 

unlocking, diagnostics, and even 

remote startup—got me wondering 

how Apple might approach stream-

lining the typical car dashboard and 

overhauling the driving experience. 

And I guess I’m not the only one.

iOS CENTRAL iOS 9.3, CARPLAY, AND THE CHEVY VOLT

IF YOU CAN KEEP THE 
BATTERY CHARGED, 
YOU’LL BARELY USE 
ANY GAS AT ALL, BUT 
ON DAYS YOU NEED 
MORE RANGE, THE 
CAR SEAMLESSLY 
STARTS USING GAS 
WHEN THE BATTERY 
RUNS OUT. IT’S 
AUTOMATIC—YOU’RE 
JUST CRUISING.
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Have you taken the CarPlay 

plunge yet? Or are you just fine 

with connecting your iPhone to 

your car’s plain old stereo over 

Bluetooth or USB? (At least you 

don’t have to wait for new features 

to trickle down to CarPlay.) For 

much more detail on the Chevy 

Volt, check out my colleague 

Melissa Riofrio’s excellent write-up 

(go.macworld.com/2016voltrev) for 

PCWorld. ■

CHEVROLET DESIGNED 

the 2016 Volt to 

look and feel more 

mainstream.
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How to install and use  
third-party keyboards on  
your iPhone or iPad
Are you still using iOS’s built-in keyboard? It’s easy to switch to a third-party 
keyboard that may better suit your needs. We’ll show you how.

BY NICK MEDIATI

iOS CENTRAL
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R
eleased in fall 2014, iOS 8 brought with it a truckload 
of new features—one of which was the ability to swap 
out Apple’s built-in keyboard with one of your choos-
ing supplied by a third-party developer. After all, the 

stock keyboard isn’t for everyone, and it has its fair share of 
shortcomings.

If you’ve never tried a new keyboard, 

now’s a good time to explore your 

options, and making the switch is a 

fairly easy process. Here’s how to go 

about it.

BEFORE WE BEGIN, A NOTE 

ABOUT PRIVACY

Since third-party keyboards can 

access anything you type in, there are 

some privacy risks inherent to using 

such a piece of software. As Apple 

notes in a privacy disclaimer nestled in 

the Settings app, third-party keyboards 

may be able to send anything you type 

to that company’s servers. For exam-

ple, a keyboard may need to commu-

nicate with a server in order to analyze 

what you type and offer up better 

autocorrect suggestions. 

Fortunately, iOS has got your back. 

Keyboards don’t receive this level of 

access—which Apple refers to as “full 

access”—by default: You have to explic-

itly allow keyboards to submit any data 

it collects to a server. Also, you can 

easily switch between and remove 

third-party keyboards as you please, so 

you can change your mind later.

FINDING A KEYBOARD

iOS treats keyboards more or less as 

apps—you have to go through the 

App Store to purchase and download 

them.

You have a number of options at 

your disposal. Swype ($1; go.mac-

world.com/swype) is one popular 

option—it allows you to swipe your 

finger over letters in order to form 

words instead of punching a word 

out letter by letter. (Want to type 

“cat”? Place your finger on the C, 

swipe up to A, over to T, then release 

your finger). SwiftKey Keyboard (free; 

go.macworld.com/swiftkeykb) is 

worth checking out as well.

Developers have come up with all 

sorts of unique and novel keyboards 

THIRD-PARTY 

KEYBOARDS may need 

to communicate with 

a server in order for 

certain features to 

work. You’ll need 

to explicitly grant 

such access to each 

keyboard you install. 
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that go beyond standard text input, 

though—see Oscar Raymundo’s 16 

delightful ios keyboards (go.mac 

world.com/ioskeyboards) to get a 

taste of what awaits you. Also, 

check the Add Fun Keyboards page 

accessible through the App Store’s 

Utilities section (open the App 

Store, tap Categories, then tap 

Utilities).

Once you find a keyboard you 

want to try, go ahead and download 

it like you would any other iOS app. 

(For the sake of this article, I’m using 

SwiftKey’s keyboard.)

SETTING UP YOUR  

NEW KEYBOARD

Once you download and install your 

new keyboard, you’ll have to tell iOS 

that you want to actually use it. To 

start, open the Settings app, tap 

General, then tap Keyboard. Tap 

Keyboards—it’s the first item listed on 

the screen—then tap Add New 

Keyboard.

You’ll find your new keyboard 

under the Third-Party Keyboards 

subheading, but before you proceed, 

you should tap About Third-Party 

Keyboards & Privacy to learn more 

about the aforementioned privacy 

implications of using a new key-

board.

Now that you know what you’re 

getting into, tap Done, and on the 

following screen, tap the name of 

the keyboard you just downloaded. 

iOS CENTRAL THIRD-PARTY KEYBOARDS

FROM FUN TO 

PRACTICAL, the App 

Store offers plenty of 

keyboards for you to 

try out.
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Just like that, your new keyboard 

will be added to the list of installed 

and active keyboards on your 

device. Tap your newly installed 

keyboard’s name to get at more 

options, including the aforemen-

tioned Full Access mode.

At this point, you may want to hop 

into the keyboard app itself to see if 

there are any additional configura-

tion options. For instance, if you use 

SwiftKey, you can sign in to or create 

a SwiftKey account in order to get 

more features beyond the basic 

keyboard. 

USING YOUR NEW KEYBOARD

Now that that’s all out of the way, it’s 

time to actually use your newly-

installed keyboard. Open an app that 

accepts text input—like Notes—then 

bring up the keyboard. Tap and hold 

the Globe key until a keyboard 

picker menu pops up. Select the 

keyboard you just installed, then start 

typing. If you want to switch key-

THE KEYBOARD PICKER menu lets you quickly 

and easily switch between keyboards you have 

installed.

ONCE YOU INSTALL a new keyboard, activating it is 

just a few taps away in the Settings app.
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boards, you can do so at any time—

just repeat this process and pick the 

keyboard you want to use.

DEACTIVATING OR  

DELETING A KEYBOARD

If you want to remove a keyboard 

from the keyboard picker menu, 

head back to Settings → General → 

Keyboard, then tap Keyboards. Tap 

the Edit button, then tap the red 

minus sign (–) button. Tap Delete to 

confirm that you want to remove that 

keyboard from the keyboard picker.

Note that doing so doesn’t actually 

delete the keyboard from your 

phone—you can always add it back 

to the list by tapping Add New 

Keyboard and then picking the 

keyboard you want to use.

You can remove the default 

keyboard from the list if you never 

want to see it again, and you can 

rearrange the order in which key-

boards appear in the picker menu. 

Once you’re finished, tap Done.

But what if you want to delete a 

third-party keyboard from your 

phone entirely? It’s simple: Find the 

keyboard’s icon on the home screen, 

then press it until the home screen 

icons start jiggling around (don’t 

press down too hard if you own an 

iPhone 6s or 6s Plus, though—you 

might invoke the 3D Touch feature 

instead). Tap the X, confirm you want 

to delete the keyboard app, then 

press the Home button.

Do you have a favorite third-party 

keyboard? ■

YOU CAN DISABLE or 

re-enable any third-

party keyboards you 

installed at any time.
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3 iPhone battery cases 
that might be right for you
Here’s how Apple’s Smart Battery Case stack up against two competitors.

BY OSCAR RAYMUNDO

iOS CENTRAL

VIDEO

To view this  
video, go to go.
macworld.com/

iphonebatcasesvid
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W
e’ve all had this collective freakout: You need a get a 
hold of someone or find directions back home but 
then your iPhone dies.

Luckily, you don’t have to go through 

that ever again as long as you have 

an external battery case for your 

iPhone. But which one is right for you? 

This time on The iPhone Show (go.

macworld.com/iphoneshow), we test 

three of the latest iPhone battery 

cases: Apple’s Smart Battery Case, 

Mophie’s Juice Pack Reserve, and 

Kuke’s Smart Case.

If you have an iPhone 6 or 6s, 

Apple makes a premium battery case 

for $99 (go.macworld.com/

applebatterycase). Apple’s Smart 

Battery Case has enough juice to 

keep your iPhone charged for 18 

hours of Internet use. And yes, you’ll 

be able to get over the hump–

especially when you realize that the 

hump actually makes it easier to slide 

your iPhone in and out.

For a more affordable option (or if 

you need a battery case for an older 

iPhone model), look to Mophie. The 

company’s Juice Pack Reserve (go.

macworld.com/juicepackres), for 

example, is $60 ($57 on Amazon; go.

macworld.com/juicepackresama 

zon) and keeps your iPhone running for 

16 hours. The one caveat is that it is not 

compatible with the Lightning connec-

tor, so you’re going to need to bring a 

separate charger if you travel with it.

Then there’s the Kuke case (go.

macworld.com/kukecase). This smart 

case is actually thinner than Apple’s 

case, but has a 

longer-lasting 

battery. Kuke has 

a 2400mAh 

battery pack, 

compared to 

Apple’s 1877mAh 

and Mophie’s 

1840mAh. The 

best thing about 

the Kuke case, 

however, is that it 

also has an external memory pack, 

adding 16GB or 64GB (go.macworld.

com/16gbnotworthit) of additional 

storage to your iPhone (definitely a 

life-saver if you own a 16GB iPhone). 

Plus, it has a Lightning port. The only 

drawback is that it was somewhat 

difficult to take the iPhone out of this 

case. It actually made me wish it had a 

hump. You can pre-order a Kuke case 

for iPhone 6s or 6s Plus starting at $69 

for the 16GB version.

Watch the video to learn more 

about these three iPhone battery 

cases and find out which one’s the 

right for you. ■

LUCKILY, YOU DON’T 
EVER HAVE TO GO 
THROUGH THAT 
EVER AGAIN AS LONG 
AS YOU HAVE AN 
EXTERNAL BATTERY 
CASE FOR YOUR 
iPHONE.
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Apple Watch’s 
second year: 
Health apps  
will make it a 
must-have
Forget Hermès bands. Let’s think bigger.

BY CAITLIN McGARRY

iOS CENTRAL
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T
he Apple Watch started shipping about one year ago. I 
still wear mine almost daily—after breaking it and going 
through a lengthy and arduous repair process (go.
macworld.com/shatteredawatch)—and find it incredibly 

useful. Is it essential for daily life? Of course not. Chances are you 
already own an iPhone, which has many of the same features. But 
you can’t wear an iPhone on your wrist, and that’s why the Apple 
Watch will become a key component in Apple’s product lineup—
even if it doesn’t seem like it yet.

The Apple Watch (go.macworld.com/

applewatchfaq) doesn’t have a “killer 

app,” critics say. Seeing notifications 

on your wrist is nice, and possibly 

less rude than checking your iPhone 

every time it vibrates, but is that 

really worth $300 (or more)? For 

many, probably not. That could be 

why Apple hasn’t sold many watches 

compared to iPhones. The company 

doesn’t break out Apple Watch sales 

in its quarterly earnings reports, but 

KGI analyst Ming-Chi Kuo pegged 

2015 watch shipments at 10.6 million 

and estimates just 7.5 million watches 

will ship this year. Shipments don’t 

equal sales, but Fluent, a customer 

acquisition company, recently 

surveyed 2,578 randomly selected 

Americans and found that just 197 of 

them, or 8 percent, owned an Apple 

Watch.

These data points are useful, 

though not exactly scientific. Fluent’s 

sample size isn’t very big, but the 

survey found that 56 percent of 

Apple Watch owners use the device 

for health and fitness monitoring 

more than any other feature. This 

might seem obvious, because fitness 

bands are huge right now and Apple 

has highlighted the watch’s activity-

tracking features in ad campaigns. 

THE APPLE WATCH’S 

“killer app” could 

be Health.
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But the Apple Watch has the poten-

tial to do so much more than just 

nudge you to stand and count your 

steps. Once that potential is realized, 

the Apple Watch will be a must-buy.

WHAT IT CAN VS.  

WHAT IT COULD DO

The Apple Watch has a heart-rate 

sensor that measures your heart rate 

continuously when you start an 

exercise in the watch Workout app, 

or every 10 minutes otherwise. There 

are well-documented instances (go.

macworld.com/awsaveslives) of the 

Apple Watch saving lives with its 

heart-rate data. The watch also 

prompts you to stand every hour, 

because according to the latest 

research, sitting all day will kill you. 

The rollout of watchOS 2 last Sep-

tember allowed third-party app 

developers to run natively on the 

watch, which means the exercise 

apps (go.macworld.com/awfitnessa-

doption) you’re already using on your 

phone can tap into the sensors on 

your watch. That’s all great.

But the Apple Watch could do so 

much more. Imagine if the watch had 

skin-capacitive sensors that could 

detect cortisol levels in your sweat, or 

a sensor that could track blood flow 

(go.macworld.com/bloodflowsensors) 

beneath your skin. Over the last year, 

Apple has focused on personalizing 

the device with interchangeable 

bands, 

including high-

end options from Hermès (go.

macworld.com/hermesbands). Those 

bands, which take up more of your 

wrist than the watch case itself, look 

great, but imagine if they were smart.

Apple recently filed a patent 

application (go.macworld.com/

modularbandpatent) for smart watch 

bands with modular pieces. The 

patent covers a band that has 

multiple links, each with an electrical 

component. Those components 

could include an actuator, an elec-

tricity generator, a photovoltaic cell, 

a speedometer, GPS, a thermometer, 

a blood pressure sensor, a sweat 

sensor, a magnetic field sensor, a 

iOS CENTRAL APPLE WATCH’S SECOND YEAR

THE APPLE WATCH 

band could one 

day be smart.
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speaker, a force sensor, and more, 

according to Apple’s filing on March 

31. Can you imagine? I want all of 

those options right now.

Apple patents all kinds of tech-

nologies that have yet to make it into 

actual devices, but the application 

proves the company is considering 

the ways in which the watch could be 

the ultimate health device. The watch 

band, which has until now been 

positioned as a fashion accessory, 

could play a huge role in that effort.

HOW APPLE WATCH FITS 

WITH THE -KITS

The Apple Watch is also the perfect 

device to unite Apple’s trio of health 

initiatives: HealthKit (go.macworld.

com/healthkitios8), ResearchKit (go.

macworld.com/researchkit), and 

CareKit (go.macworld.com/carekitin-

tro). HealthKit puts all of the health 

data your iPhone and various third-

party health apps collect into one 

centralized place, the iOS Health 

app. ResearchKit opened up your 

iPhone and Apple Watch to medical 

researchers, who can use the 

devices to study you (if you let them). 

And Apple’s recently launched 

CareKit is still in early days—those 

apps haven’t yet hit the App Store—

but will soon allow doctors and 

hospitals to help you manage your 

health at home.

Those developer frameworks are 

tied to the iPhone, but there’s no 

reason they can’t make use of the 

Apple Watch. Some already do: The 

CAREKIT TURNS YOUR 

iPhone into a doctor. 

It could do the same 

for your watch.
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iOS CENTRAL APPLE WATCH’S SECOND YEAR

EpiWatch app from Johns Hopkins (go.

macworld.com/awepiwatch) research-

ers uses the watch’s sensors to 

monitor epilepsy patients, while the 

American Sleep Apnea Association’s 

SleepHealth app (go.macworld.com/

sleephealthapp) analyzes your sleep-

ing patterns from watch sensor data.

With access to the watch’s heart 

rate sensor, accelerometer, and 

gyroscope, researchers, doctors, 

family members, and watch wearers 

can already see tons of data. If Apple 

puts more sensors into the watch or 

watch band, that opens up a world of 

information that’s not just viewable, 

but actionable. if your watch strap 

has a blood pressure sensor that 

gives you readings on your wrist, it 

can warn you when readings are 

high or low enough to require 

medical intervention. That’s just one 

possibility. The options are endless.

Millions of Americans avoid going 

to the doctor until they absolutely 

have to. The watch could be a 

preventative health device, nudging 

you to seek medical attention when 

your heart rate is irregular or when 

the cortisol levels in your sweat are 

abnormal. With CareKit apps, you’ll 

be able to immediately share that 

data with a doctor. Health insurance 

companies and the employers who 

pay them will love this.

There are many, many steps for 

Apple to take between selling the 

Apple Watch of today and building 

the game-changing device I predict it 

could be in the future. Beyond just 

the technical feasibility of putting 

those advanced functionalities into 

the watch, Apple can’t market it as a 

medical device without approval 

from regulators.

THINK DIFFERENT

Maybe I’m being overly optimistic 

about the Apple Watch’s potential. 

Plenty of people seem satisfied with 

the watch as it is right now. The device 

has scored high in customer satisfac-

tion surveys, including the latest one 

from Fluent. But Apple is nothing if not 

a company with big ideas and the 

attention to detail required to pull them 

off—not to mention the commitment to 

privacy necessary to keep medical 

data secure. I think it has grander 

ambitions for the watch.

For now, no one needs an Apple 

Watch. I use mine to send and 

receive texts, track my workouts, and 

tap Macworld Executive Editor Susie 

Ochs on the wrist when I think she’s 

ignoring my Slack messages. Are 

those essential to my happiness? Of 

course not. But Apple could turn the 

watch into a must-have health 

device, not just a fashion-forward 

tech accessory. The company’s 

“most personal device ever” could 

eventually help you live a better life. 

That will justify its existence. ■
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NETWORK UTILITY 

SPEEDIFY: FASTER, MORE 
RELIABLE INTERNET FOR YOUR 
iOS DEVICES
BY J.R. BOOKWALTER

SERVICES OFFERING VIRTUAL PRIVATE NETWORKS (VPNs) have 

become a booming business, and with good reason. Corporations 

depend on them for the additional layer of security they provide, and 

world travelers benefit by being able to take many of their favorite 

streaming video subscriptions abroad with them.

But there’s another use for VPN you might not be aware of, one that 

can make any available Internet connection faster and more reliable in 

REVIEWSiOS CENTRAL

SPEEDIFY  

MOBILE (iOS)

mmmm
AT A GLANCE

Speedify combines  

available cellular and Wi-Fi 

connections, seamlessly 

providing faster, more 

reliable Internet speeds  

from any iOS app.

PROS

Internet connectivity for  

iOS devices

cellular data connections

persistent connectivity

CONS

unlimited use

connections

PRICE

available

COMPANY

Speedify.com
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just a few taps. If you’re VPN-curious 

and looking to squeeze the most out 

of your mobile connectivity, it’s as easy 

as downloading an app.

THE NAME’S BOND

Speedify (speedify.com/mobile; go.

macworld.com/speedifyitunes) isn’t a 

VPN in the traditional sense, but rather 

a free, universal iOS app used to bond 

available Wi-Fi and cellular connec-

tions. Rather than focus strictly on 

security, the service splits traffic 

between channels, making it possible 

to seamlessly switch between them as 

needed.

To get started, you’ll need to sign up 

with an email address. Free accounts 

receive 1GB of data transfer per 

month, but can earn more through 

referrals. You can also purchase paid, 

mobile-only unlimited usage upgrades 

priced at $5 per month or $30 annu-

ally. (A desktop version is also avail-

able for $18 per month or $88 per 

year, which includes mobile access; 

however, only one session per 

account can be active at a time.)

The app is easy to set up: Grant 

permission to create a new VPN 

connection, then select the closest 

available server. While active, a VPN icon appears at the top of your 

home screen next to the usual cellular and Wi-Fi options. Speedify runs 

in the background even when the app is closed, routing data through its 

own secure server before sending it through the open Internet.

While Speedify is open, a dashboard displays real-time graphs that 

measure usage, color-coded by the type of connection. In typical use, 

SPEEDIFY OFFERS granular 

control over cellular data 

connections to avoid 

exceeding your carrier’s 

monthly allotment.
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Wi-Fi is used by default, but switches to cellular on occasion for quick 

speed boosts, or to assure a smooth, interruption-free handoff between 

connections.

SERVING SPEED

If you’re one of the millions on a cellular plan that limits the amount of 

data available each month, Speedify can be configured with daily and 

monthly caps to prevent the service from consuming too much band-

width. Should you exceed either limit, the app sends a push notification 

requesting an increase, but only with your approval.

There’s an option to prevent Speedify from using cellular entirely, or 

treating such connections as a backup, used only when nothing else is 

available. The Connections screen provides feedback on how much data 

each adapter is using, which can be reset to start the meter running again; 

the Advanced screen reveals any latency and loss present in the current 

connection.

In average 

use, the speed 

bump provided 

by Speedify is 

modest at best, 

but I immediately 

noticed the 

difference when 

streaming video. 

Services like 

Amazon Video 

started instantly, 

although Netflix 

doesn’t work at 

all now that the 

service actively 

blocks VPN 

connections. 

While earlier 

versions would 

drop the connec-

IF YOUR DAILY or monthly 

data limit is exceeded, 

Speedify will gently 

nudge you to increase it 

so you can keep going.
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tion when the device was idle too long, version 

3.4 introduces support for persistent connec-

tivity.

Speedify did smooth out a bump in my 

home wireless network, which uses a pair of 

linked AirPort Extreme routers for wider 

coverage. There’s a known dead zone in my 

hallway right between the two routers, but 

Speedify successfully filled this brief gap using 

cellular connectivity, allowing downloads or 

streaming video to continue without missing a 

beat. 

BOTTOM LINE

Speedify makes the most of any available 

Internet connection, and it’s easy to configure 

and use, but not necessarily the most reliable 

on iOS devices. ■

SPEEDIFY USERS CAN select the closest available VPN server, or 

manually select one from the provided list of choices.
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STORAGE DEVICE 

TRANSCEND JETDRIVE GO 300: CURE 

FOR THE 16GB iOS DEVICE BLUES
BY J.R. BOOKWALTER

WHY APPLE CONTINUES to sell iOS devices with a meager 16GB of 

storage is a question only executives in Cupertino know the answer to. If 

you’re stuck with a low-capacity iPhone, iPad, or iPod touch, Transcend 

has a new accessory that offers some much-needed room to breathe.

DUAL CONNECTIVITY

Measuring 2.22 x 0.79 x 0.31 inches and weighing barely a quarter-

ounce, the JetDrive Go 300 ($45 to $95 on go.macworld.com/tran-

scendjetdriveamz) is a diminutive flash drive that works equally well 

with iOS devices, Macs or PCs. One end is an MFi-certified (Made For 

iDevice) Lightning connector, while the opposite end is a USB 3.1 Gen 1 

Type A connector.

Sandwiched between the connectors in a metallic black or silver 

chassis are 32GB, 64GB, or 128GB of flash storage (my review unit was 

a 64GB silver one). It’s super-lightweight and pocket-friendly, but 

REVIEWSiOS CENTRAL

TRANSCEND 

JETDRIVE GO 300

mmmh
AT A GLANCE

Available in 32GB, 64GB,  

and 128GB capacities, the 

Transcend JetDrive Go 300 is 

a flash drive for your iOS 

devices that also plays nice 

with Mac OS and Windows.

PROS

connectors

app

CONS

PRICE

32GB, $45; 64GB, $65; 

128GB, $95

COMPANY
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there’s no hole to attach a keychain, nor are the end caps connected in 

any way, making the accessory easy to misplace.

Although the accessory offers dual connectors, they can’t be used at 

the same time. Drawing power from the host device, the JetDrive Go 

300 features internal, non-swappable flash storage formatted FAT32 for 

cross-platform compatibility with files up to 4GB in size. (Don’t bother 

reformatting; the companion iOS app supports only FAT32.)

THE JETDRIVE GO app allows for moving photos and videos back 

and forth between the iOS device and flash drive.

THE FREE JETDRIVE GO APP can access content stored on the flash 

drive, inside the app, or in your iOS device’s Camera Roll.
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FLASH OF LIGHTNING

Using the USB connector, JetDrive Go 300 is capable of impressive 

transfer speeds up to 130MB per second. I was able to copy a 3.2GB 

file from my mid-2012 MacBook Pro with Retina Display in about two 

minutes flat, only 15 seconds longer than a traditional USB 3.0 thumb-

drive, Transcend’s JetFlash.

To use with Lightning-equipped iOS devices, you’ll need to install 

the free JetDrive Go app (go.macworld.com/jetdrivegoapp), sum-

moned whenever the accessory is plugged in. Transfers to or from iOS 

are capped at 20MB per second—an Apple hardware limitation—but 

that’s plenty fast enough for transferring documents, music, photos, or 

MP4 video files, with a negligible impact on battery life.

With JetDrive Go, users can shoot photos and videos directly to the 

flash drive, or copy and move Camera Roll content back and forth. 

There’s also one-tap backup for photos and/or videos, with the handy 

option to disable iCloud Photos and skip content that hasn’t been 

downloaded in full resolution. Although JetDrive Go can share to 

other apps, there’s currently no iOS extension support for saving 

directly to the flash drive.

BOTTOM LINE

You can’t attach it to a keychain, but otherwise the Transcend JetDrive 

Go 300 is a versatile, affordable flash drive for storage-constrained iOS 

devices. ■

DESPITE THE JetDrive Go 

300’s dual connectors, 

only one can be used 

at any time.
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What’s new  
at the  
App Store

MELODY JAMS
Melody Jams (melodyjams.com) 

lets you mix-and-match monster 

characters to create your own 

songs. You choose sounds, mix 

melodies, and make all the 

music you want on the instru-

ment of your choosing. Check 

out their video demonstration 

(vimeo.com/154951931).
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Digit
Digit (digit.co) is a variation on the idea 

behind the popular Acorns app (acorns.

com)—the idea in both cases is to help 

you nickel-and-dime your way to savings: 

“Every few days, Digit checks your spending habits 

and saves a few dollars from your checking account if 

you can afford it.” Typically the amount will be between 

$2 and $17, and the service promises that it will never 

be more than you can afford.

Budge
Budge (go.macworld.com/budge) is a $1 

app that lets you combine a shopping list 

and budget to create what it calls a (natch) 

“budgeted shopping list.” The idea? Keep a 

running tally of how much you’re spending as you load 

up the shopping cart, and make sure you don’t acciden-

tally exceed your spending limits.

ProtonMail
ProtonMail (protonmail.com) is for the 

security conscious—you can send and 

receive encrypted emails, and if you’re 

really nervous about prying eyes, you can 

even program outgoing messages to self-destruct after 

a set period of time. The app is free; if you like it, you 

can donate to the developers, or purchase a premium 

account, which starts at $5 a month.

Screens VNC
The $20 Screens VNC (edovia.com/

screens) has launched Version 4.0 of 

letting you look at your Mac desktop from 

your iOS device; the new version includes 

a “curtain mode” that lets you keep the desktop hidden 

even as you access it, as well as multitasking support 

and better 1Password integration.  —JOEL MATHIS
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BY EMANUELA CORSO AND MARCO TABINI 

Selfies without the stick
This month’s roundup features the Flip It Nite, which packs a retractable arm that 
acts as a selfie stick, and Prynt which turns your iPhone into a photo printer. Plus, 
two waterproof cases, a battery-amplifier case and one that includes a micro dock.  
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NEUMAGINE
The Flip It Nite (iPhone 6/6s; $50 MSRP; 

flipitcase.com) is a hard-shell case with a 

built-in kickstand. Available in black or white, 

the case sports a retractable steel telescopic 

arm that extends up to 25 meters for all of 

your selfie needs, and comes with a handy 

removable Bluetooth remote with which you 

can snap pictures at a distance.

NODUS
The elegant Shell Case 

(iPhone SE, 6/6s, and 6 

Plus/6s Plus; $72.68 

through Nodus, or $80 on 

Amazon; thenoduscollec-

tion.com) protects your 

iPhone in a simple 

leather-wrapped cover. 

The case includes a 

polycarbonate frame and 

a microfiber lining for 

added padding. It also 

features a magnetic 

docking system for 

hands-free use when 

mounted on the Micro 

Dock, which ships with 

the case.
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DOG & BONE
The compact Wetsuit (iPhone SE; $59.95; dogandbonecases.com) is a 

waterproof iPhone enclosure that prevents damage even under 

harsh and demanding conditions. This case features a 

perimeter membrane that creates a water-tight seal 

around your iPhone’s display, so that you can 

freely access your screen without the need for 

a protective cover. With this case, your 

iPhone can be fully submerged in water up to 

two meters deep, and it’s certified to keep 

your iPhone safe when dropped from a height 

of up to six feet.

PRYNT CASE  
Available in white or black, the Prynt 

Case (iPhone 6/6s; $150; prynt.co) 

provides you with everything you need to 

turn your iPhone into a portable photo 

printer. The case sports an internal 

battery to power the printer, and a hidden 

compartment to store photo paper. 

Together with its companion app for iOS, 

the Prynt Case offers a full set of 

photo-editing and post-production features 

for instant prints—like a high-tech Polaroid.

79

http://www.softgozar.com


iOS CENTRAL

Selfies without the stick

80

PATCHWORKS  
Manufactured with 

Saffiano leather, the 

fashionable Wallet (iPhone 

6/6s; $79) sports a folio 

design with a zippered 

back pocket for your 

change or your cash. The 

case features a soft-to-the-

touch, scratch-resistant 

finish, three interior credit 

card slots, and a gold 

cradle to secure your 

iPhone. The Wallet comes 

in baby pink, black, navy, 

pink, or red.

CATALYST
The just-announced Catalyst Case (iPhone 

SE; $70) offers full-on waterproof protection, 

with a transparent front and back that shows 

off your iPhone SE’s design. Made with 

polycarbonate, this rugged case has been 

tested to withstand drops from up to six feet 

high, can be submerged in depths up to 16 

feet, and is compatible with the iPhone’s 

touchscreen through its thick screen 

protector. The Catalyst Case comes with a 

lanyard for hands-free carrying and is 

currently available for pre-order, with 

shipping expected to 

begin in May.
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Just because  
you can’t see it 
doesn’t mean 
it’s not there.
Although it’s more common in older women, ovarian cancer 

afects women of all ages, even in their 20s. There is no early 

detection test, and symptoms can be subtle. But while you  

can’t see it, you can take steps to get ahead of it by knowing 

your risk factors. Family history of cancer and presence of  

gene mutations like BRCA are risk factors, so talk to your  

family and your doctor. This information makes you less  

likely to ignore vague signs that could indicate disease. 

Meanwhile, promising collaborative research  

will continue to shed light on new advances in  

diagnosis and treatment of ovarian cancer. 

To learn more about symptoms,  

risk factors and research go to 

SU2C.org/ovarian

Stand Up To Cancer is a program of the Entertainment Industry Foundation,  
a 501(c)(3) non-profit organization.

Minnie Driver

Stand Up To Cancer Ambassador

Photo by Martin Schoeller
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 MACBOOK 2016 REVIEW:

ULTRA- 
PORTABLE 
LAPTOP 
SATISFIES 
WITH SPEED 
GAINS

IT’S NOT A DESKTOP MAC REPLACEMENT.  

THE MACBOOK IS IDEAL FOR ON-THE- 

GO USE. BY ROMAN LOYOLA

82
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W
hen it 

comes to 

hardware, 

Apple isn’t afraid 

to force its users to adapt, to 

change habits. Longtime Mac users 

remember when Apple stopped including 

floppy and optical drives, or when FireWire 

was discontinued. More recently, Mac users 

have had to accept the inability to upgrade hard 

drives and RAM, or that the Magic Trackpad 2 is the 

preferred input device, with its support for gestures that 

can’t be performed on a Magic Mouse 2.

The MacBook (go.macworld.com/macbook2016) is one of 

those game changers. When it was released last year, it was 

pretty obvious that Apple wanted to push its users in a certain direc-

tion, to a place where there are no wires, where you depend on the 

cloud, where you can carry a laptop effortlessly and never worry 

about the battery running out.
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The push was more like a big 

shove. Apple’s thinnest and lightest 

laptop has only one port for connect-

ing devices, and it sports a processor 

that sacrifices performance. And Mac 

users pushed back, especially about 

the single port. It wasn’t hard to find 

someone who wished that the 

MacBook was more like the Mac-

Book Pro or that Apple would do 

something with the MacBook Air. 

(Apple did do something with the 

MacBook Air, the 13-inch model 

specifically. It now comes standard 

with 8GB of memory instead of 4GB.)

When Apple announced that it was 

updating the MacBook, Mac fans 

clicked on news links in anticipation. 

Will Apple add another port? Or maybe 

upgrade from USB-C to Thunderbolt 

3? How ‘bout an HD FaceTime camera 

instead of the 480p camera that was 

on last year’s MacBook?

Nope, sorry. None of those fea-

tures were added. But Apple did 

upgrade the processors and graph-

ics. That’s certainly nothing to scoff 

at. In fact, the MacBook closes the 

THE 2016 MACBOOK is 

just as thin and light as 

its predecessor. All the 

changes in the new 

version are inside the 

aluminum case.

FEATURE     RE V I E W ED: M ACBOO K 20 1 6

PHOTOGRAPH BY ROMAN LOYOLA
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gaps between itself, the MacBook 

Pro, and the MacBook Air, so much 

so that for general use, the speed 

should satisfy most users.

The MacBook also has longer 

battery life. Apple’s battery specifica-

tion is now an hour longer than the 

previous MacBook; 10 hours for 

“wireless web” and 11 hours for 

“iTunes movie playback.” Apple told 

me that the longer battery life is due 

to better battery chemistry. The size 

of the battery is the same as before.

And, oh yeah, the MacBook is 

available in Rose Gold now, in addi-

tion to Gold, Silver, and Space Gray. 

You won’t find those color options 

with the current MacBook Pro and 

MacBook Air, for what it’s worth.

A BETTER 
PERFORMER
Everything on the outside of the 

MacBook is the same as before, so I 

won’t dive into my thoughts on things 

like its size, weight, and construction; 

the 12-inch, 2304 x 1440 Retina 

display; the Force Trackpad; or the 

keyboard. For more details about 

these parts, see our review of the 

2015 MacBook (go.macworld.com/

usbcmacbook) by Jason Snell. His 

APPLE DIDN’T CHANGE 

anything on the 

exterior of the 

newest edition of 

the MacBook. It has 

the same screen, 

keyboard, and 

trackpad found in 

the 2015 version.
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thoughts still hold up and jibe with 

my thoughts, though maybe I dislike 

the keyboard more.

The major changes are internal, so 

let’s focus on those. The MacBook 

now has Intel Skylake processors, an 

upgrade from the Broadwell proces-

sors used when the MacBook was 

introduced last year. Apple uses the 

Core M version of Intel’s processors 

in the MacBook, which are designed 

for mobile devices.

Apple offers two standard configu-

rations: the $1,299 MacBook features 

a 1.1GHz dual-core Core m3 processor 

with Turbo Boost up to 2.2GHz, and 

the $1,599 MacBook has a 1.2GHz 

dual-core Core m5 processor with 

Turbo Boost up to 2.7GHz. (Both 

models have 4MB L3 cache and 8GB 

of 1866MHz LPDDR3 RAM.) For an 

additional fee, you can upgrade the 

processor to a 1.3GHz dual-core Core 

m7 processor with Turbo Boost up to 

3.1GHz. (This review focuses on the 

$1,599 MacBook.)

FEATURE     RE V I E W ED: M ACBOO K 20 1 6

MacBook (2016)
1.2GHz dual-core  
Core m5 (Skylake)

MacBook (2015)
1.3GHz dual-core  
Core M (Broadwell)

MacBook (2015)
1.2GHz dual-core  
Core M (Broadwell)

Geekbench 3 Single-core (score) Geekbench 3 Multi-core (score)

MacBook (2015)
1.1GHz dual-core  
Core M (Broadwell)

2927

2637

5276

2437

5049

2299

4489

5875

64-BIT GEEKBENCH 3: 2015 VS. 2016 MACBOOKS
Longer bars/higher scores are better.
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How much of a speed improvement 

does the 2016 MacBook offer on last 

year’s version? Using Geekbench 3 (go.

macworld.com/geekbench), the 1.2GHz 

Core m5 offers an increase ranging 

from 11 to 30 percent, depending on the 

older processor that it is being com-

pared to. For example, in Geekbench’s 

64-bit multi-core test, the 1.2GHz Core 

m5 is 11 percent faster than the 1.3GHz 

dual-core Core M processor that was an 

upgrade option for the 2015 MacBook. 

Another example: In the same test, the 

1.2GHz Core m5 is 30 percent faster 

than the 2015 MacBook’s 1.1GHz Core M 

processor. Generally speaking, the 

speed increase isn’t unusual; we’ve 

seen similar increases in past Mac 

laptop upgrades. Faster is always better.

64-BIT GEEKBENCH 3 
RESULTS: 2016 AND 
2015 MACBOOK
Now let’s compare the performance 

to the MacBook Air. Last year’s 

MacBook was about 9 percent slower 

than the current 1.6GHz MacBook Air 

(which was released in March of 2015 

with a Broadwell processor). That 

speed difference threw a wrench into 

a shopper’s decision making: Pay 

$1,199 for a faster 13-inch MacBook Air 

or spend $1,299 or $1,599 for a slower 

MacBook? (Sure, there are other 

differences to consider, like the 

display and ports, but I’m simplifying 

here for argument’s sake.)
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Fortunately, with the new MacBook, 

you feel like you’re getting perfor-

mance that better justifies the price 

difference. The 1.2GHz Core m5 

MacBook is 12 percent faster than the 

1.6GHz MacBook Air in Geekbench’s 

single-core test; that’s a nice boost 

compared to last year, where the 2015 

MacBook was as fast or slower 

(depending on which processor you 

pick) than the MacBook Air. In Geek-

bench’s multi-core test, the new 

MacBook was just 1 percent faster 

than the MacBook Air. But to put that 

in perspective, last year’s MacBook 

was slower than the MacBook Air by a 

range of 9 to 20 percent.

For reference, I also compared the 

1.2GHz Core m5 MacBook to the 

current 13-inch MacBook Pro models, 

which have Broadwell processors. 

Interestingly, the MacBook isn’t far 

behind in Geekbench’s single-core 

test. That means that for tasks like 

email, writing apps, spreadsheets, and 

basic websites, you may not notice a 

speed difference between the two 

different laptops. But as expected, the 

MacBook Pro blows past the MacBook 

in Geekbench’s multi-core test. 

Translation: With apps that can use 

multiple processing cores, like profes-

FEATURE     RE V I E W ED: M ACBOO K 20 1 6

VIDEO

To view this video, 
go to go.

macworld.com/ 
2016mbookvid
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THE MACBOOK’S USB-C 

port is for charging 

and connecting 

peripherals. If you 

want more ports, you 

either need to 

connect a USB-C hub, 

or consider a 

MacBook Air or 

MacBook Pro.

sional video, audio, or image editors, 

you’re better off with a MacBook Pro.

One last platform comparison: 

How does the new MacBook stack 

up against the iPad Pro from a pure 

performance standpoint? You might 

be surprised. Both the 12.9-inch and 

9.7-inch iPad Pro perform in line with 

the new MacBook. Just another thing 

to consider (or to make your decision 

more complicated).

PORT OF 
CONTENTION
Of course, there’s more than perfor-

mance to consider when picking a 

Mac laptop. As I mentioned earlier, 

much of what the MacBook offers 

hasn’t changed from last year and 

was covered in our previous review. 

But the single USB-C port is a serious 

point of contention for shoppers, so I 

feel I should address it.

Apple positions the MacBook as the 

laptop for the wireless world, with 

“wireless” meaning more than just your 

Internet connection. It also applies to 

external input devices (there’s Blue-

tooth for that) and external storage (the 

cloud). (There is an audio-out jack on 

the opposite side of the MacBook, so 

you can still use wired headphones 

and speakers.) You shouldn’t really 

need to use the USB-C port, except 

when you need to charge the laptop.

Why didn’t Apple upgrade the port 

to Thunderbolt 3, which uses the 

same port type and is compatible 

with USB-C? When I posed this 

question to Apple, a representative 

said that Thunderbolt 3 has chip and 

thermal considerations that don’t fit 

with the MacBook’s fanless design. 

It’s not as simple as slipping in a 

YOU SHOULDN’T 
REALLY NEED TO 
USE THE USB-C 
PORT, EXCEPT 
WHEN YOU NEED 
TO CHARGE THE 
LAPTOP.
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Thunderbolt subsystem in place of 

USB-C, so if Thunderbolt 3 ever does 

make it to the MacBook (if it’s pos-

sible), it’s going to take some re-

engineering of the internals.

The MacBook’s single USB-C port 

is a deal-breaker for some. You’ll have 

to go with a MacBook Air or a Mac-

Book Pro. But you really want the size 

and weight of the MacBook, you say? 

You could wait another year and see if 

Apple finally relents and adds another 

port. It’s not unprecedented. The first 

MacBook Air in 2008 had only one 

USB port, and then Apple added a 

second USB port two years later.

Another option is to wait and see 

what Apple does with the MacBook 

Pro. Apple’s Worldwide Developers 

Conference is in June, and the current 

MacBook Pro is a year old. Seems like 

the time is right for a MacBook Pro 

update between now and WWDC. 

The rumors say that Apple is working 

on “ultra-thin” 13- and 15-inch Mac-

Books, so if you’re waiting for a 

MacBook Pro, you need to hold on for 

a few more weeks.

What about the MacBook Air? I think 

some people still think of the MacBook 

Air as the ultra-portable laptop; after all, 

that’s how it was positioned when it 

was released. Longtime users even 

remember the previous MacBook line, 

which was positioned as the affordable 

laptop. But the MacBook is now the 

ultra-portable. The MacBook Air is 

Apple’s affordable laptop, à la the Mac 

mini. And I wouldn’t be surprised if it 

was treated like the Mac mini, with an 

update cycle that’s much longer than 

other Macs.

THE iPAD PRO 
OPTION
Maybe one of the reasons why some 

don’t understand the purpose of the 

MacBook is because the MacBook is 

being considered from a laptop 

user’s point of view. But if you think 

about it from an iPad user’s point of 

view, the MacBook starts to make 

more sense. iPad users are used to 

not having to connect devices to 

their tablet and relying 

on wireless connec-

tions, so having one 

port on a laptop isn’t 

that big of a deal.

Now, I get that the 

notion of iPad-first may not seem 

practical, but I don’t think it’s unreal-

istic. Kids are using iPads in school, 

and people do use smartphones and 

tablets as a primary computing 

device.

If available ports are not an issue, 

then the iPad Pro could be an option 

FEATURE     RE V I E W ED: M ACBOOK 20 1 6

SEE THE  
BENCHMARKS

For a look 

at the 

numbers 

and how they 

compare, we’ve 

posted several bar 

charts at go.

macworld.com/

mb16bm. You’ll 

also find a set of 

benchmarks for 

Cinebench 

OpenGL and 

Blender.

THE MACBOOK AIR IS APPLE’S 
AFFORDABLE LAPTOP, À LA 
THE MAC MINI. 
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over the MacBook. The 12.9-inch iPad 

Pro weighs 1.57 pounds, and with a 

keyboard case, you approach 2 

pounds. So when it comes to weight, 

there’s not really an advantage. There 

is one with the smaller iPad Pro; even 

with a keyboard case, the 0.96-pound 

9.7-inch iPad Pro will have a cumula-

tive weight under 2 pounds, though 

you end up with a smaller screen.

64-BIT GEEKBENCH  
3 RESULTS: 2016 
MACBOOK AND  
iPAD PRO
In Geekbench testing, the iPad Pro 

doesn’t disappoint against the 

MacBook. So what it comes down to 

is iOS versus OS X and the apps. Can 

you do what you need to do within 

iOS? That requires a close examina-

tion of the software you use and the 

tasks you perform.

BOTTOM LINE
For a lot of people, the MacBook is 

the ideal laptop. It’s light. It’s small. 

It’s easy to carry. And it offers good 

performance for productivity soft-

ware, though it can handle pro apps 

fine (you’ll just have to wait a little 

longer for some tasks). The MacBook 

is meant to serve the user who is 

constantly on the go, and it serves its 

purpose well.

But if what you want is the Mac-

Book Pro feature set in a MacBook 

body, then you’ll need to either wait 

and see what Apple does in the 

near future or bite the bullet and buy 

a MacBook Pro. However, if you 

want more ports but you want them 

at an affordable price, then the 

MacBook Air is the laptop for you 

and you’ll have to accept its com-

promises. ■

MacBook (2016)
1.2GHz dual-core  
Core m5 (Skylake)

12.9" iPad Pro
A9X

9.7" iPad Pro
A9X

Geekbench 3 Single-core (score) Geekbench 3 Multi-core (score)

2927

3216

5473

3030

5179

5875

64-BIT GEEKBENCH 3:  
MACBOOK VS. iPAD PRO
Longer bars/higher scores are better.
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After 12 months and 1 day, my Apple Watch is still a 
constant companion, keeping me on time, on track, and 
more aware of the world around me. By Susie Ochs
ILLUSTRATION BY YUTA ONODA

12 
REASONS I STILL 
WEAR MY APPLE 
WATCH EVERY DAY

FEATURE
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I
t’s been a year since I’ve had my Apple Watch. The things I 

complained about at the start (go.macworld.com/apple 

watchcomplaints) are still an issue, and they mostly boil 

down to the fact that even running native apps, this is the 

slowest Apple product I’ve used for a long time. Still, I’ve 

charged the battery almost every night, and worn the Apple 

Watch almost every day. I can’t help it; I’ve come to rely on the 

little thing. It doesn’t do anything my iPhone can’t do, of course, 

but some of those little tasks are suited particularly well to my 

wrist, and the watch has wormed its way into my everyday 

routine so deeply that I’m genuinely sad on the rare days when 

I accidentally leave it plugged into its charger all day.
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To prove my utter dependence on this handy little gadget, I humbly 

submit this list of the things I use my Apple Watch for, virtually every day that 

I’m wearing it. They’re not big things, they’re not “game changers,” and 

whether or not they add up to the gadget’s new starting price (go.macworld.

com/applewatch299) of $299 (go.macworld.com/buyapplewatch) is up to 

you. I do agree with Apple that the watch is the company’s most personal 

product, so everyone’s reasons to own one—or not—will be likewise pretty 

personal. But personally, I’m glad I have it.

One year in, let me know what you think of your Apple Watch. Are you still 

wearing it? Did you sell it? (go.macworld.com/byewatch) If you skipped this 

one, are you intrigued enough to consider Apple Watch 2 (go.macworld.

com/watch2rumors)? Or do you think this whole smartwatch thing is a fad? 

I’d love to hear from you. Email podcast@macworld.com and we’ll feature 

some feedback in an upcoming podcast episode.

FEATURE     A PPLE WATCH E V ERY DAY

1. SETTING TIMERS AND ALARMS 
Pizza reheats for about 5 minutes in the oven. My 

son gets iPad time in 15-minute increments. I need 

to leave here 10 minutes from now. “Hey Siri, set a 

timer for 10 minutes,” I mutter into my watch. Yes, I 

could yelp “Hey Siri” at my iPhone and set a timer 

that way, but the timer buzzing right on my wrist is 

impossible to ignore.

I use alarms for things I need to do at the same 

time every day, or every weekday, or every week—

watchOS can handle them all. Again, the iPhone 

does this just fine, but setting the alarms is quick 

with Siri, and I love having an alarm I’m wearing on 

my arm. Bonus: The Snooze and Dismiss buttons 

are crystal-clear on the Apple Watch, unlike the 

tap-to-snooze, swipe-to-dismiss gestures on the 

iPhone’s lock screen.

SOMETIMES, 

I TAP the 

Apple Watch. 

Sometimes,  

it taps me. 
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2. WRIST-TAP DIRECTIONS 
I used to always use Waze in the car. Now I’m just as likely to pick Apple 

Maps for directions (go.macworld.com/applewatchmaps) because I love 

how it taps my wrist before each turn, so I can turn off the annoying naviga-

tion voice that would otherwise interrupt my music and podcasts. I can 

even glance down at my wrist to see the name of the next street I’m turning 

on, and how far away that is, although I wish the whole process was a little 

speedier. But it’s less distracting than trying to look at my iPhone screen. 

I’ve managed to navigate to places I’ve never been before with the naviga-

tion voice turned off, just by waiting for the wrist-taps: 10 fast taps before a 

right turn, six taps that come in three pairs before a left turn.

3. TRACKING WORKOUTS 
I love the Workouts app (go.macworld.com/workouts 

app). I have tracked every spin class I’ve ever taken, 

every ride on my ultra-dorky FitDesk stationary 

bike (go.macworld.com/fitdeskbike), every 

jog I’ve huffed and puffed through since 

getting the Apple Watch—oh, and a 

year’s worth of concerts. I love going to 

a show I know where I’m going to dance 

my butt off, and then starting a workout 

right as the band takes the stage. It never 

stops amusing me that my best-ever 

workout medal is for getting particularly 

funky on the lawn at a Phish show.

 IN CASE YOU’RE wondering, at the Phish concert I burned 566 calories in 

just one set, with an average heart rate of 123 beats per minute.
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4. CLOSING THE ACTIVITY RINGS 
The Activity rings (go.macworld.com/activityrings) have kept me more 

engaged than any Fitbit or Jawbone fitness tracker I’ve tried. I love how 

the Apple Watch tracks three goals (standing, moving, and exercise), and 

something about the visual of closing a circle is just more compelling to 

me than trying to hit 10,000 steps. Speaking of steps, I also love how the 

Apple Watch primarily tracks 

calories over steps, since that’s 

gotten me to think more about 

the calories I’m eating, now that 

I’ve seen just how hard they are 

to burn. The bottom line is that 

the Activity app is the thing that 

gets me to wear the Apple Watch 

every day, and the main reason 

(go.macworld.com/watchapps) I’m 

sad on days I forget to wear it. 

(Bonus: Lately, when I get the tap 

on my wrist telling me to stand, I 

grab my hand weights and stand 

up for a minute of reps. My Fitbit 

never got me to do that.)

5. THE MODULAR 
FACE 
I hate the Apple Watch’s home 

screen of tiny app icons you can’t 

hide. So I just never use it. Most 

of the functions I need on my 

Apple Watch I can add to the Modular watch face as complications. Mine 

looks like this: Activity, time, calendar, temperature, battery life, and timer. 

Better yet, I can tap those complications (except the time and the battery 

life) to jump immediately into those watch apps. It’s not the coolest-looking 

watch face, but it’s the most useful by far.

FEATURE     A PPLE WATCH E V ERY DAY

THE MODULAR FACE 

can have third-party 

complications too,  

and tapping a 

complication is  

the fastest way 

to launch the 

corresponding  

app.
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6. DICTATING REMINDERS 
Wait a second, there’s no Reminders app on the  

Apple Watch! Nope, but I use Siri on the Apple  

Watch as a remote for sending new reminders to my 

iPhone’s Reminders app the moment I think of them.  

If I say “Add to my Things list,” it goes on a list that 

gets automatically imported into my Things to-do 

app—yes, Things has its own Apple Watch app, but  

I’m more likely to do it this way. If I ever get my 

husband to share a Reminders list with me, I could 

even add things to his list—uh, I mean our list.

7. FINDING MY iPHONE 
I’m only slightly embarrassed to admit I 

do this just about every day. I put my 

iPhone down somewhere in my single-

story, 1,100-square foot home, and 10 

minutes later I have no idea where I left 

it. Before the Apple Watch, I would pace 

around looking, getting frustrated, and 

eventually bothering my husband to call 

the darn thing. Now I swipe up on my 

watch face to Glances, and tap the 

magic iPhone-locating button in the 

Control Center. My iPhone pings. I find 

it. My family rolls its eyes at me. Every-

one’s happy.

97

http://www.softgozar.com


8. NOW PLAYING 
The Now Playing glance is incredibly useful. I don’t keep any music synced 

to the Apple Watch itself, because I don’t have Bluetooth headphones that I 

like. Luckily, Now Playing can control whatever’s playing on my iPhone, and 

my iPhone is the source of most of my music and podcast listening. The 

Apple Watch lets me pause, fast-forward, control the volume, and even 

Heart or Add songs if I’m listening to Apple Music. Tapping the name of the 

song launches Apple Music, once again keeping me away from that home 

screen. I don’t have to stick with Apple apps, either; Now Playing works just 

great with Spotify, Casts, Soundcloud, and even YouTube.

FEATURE     A PPLE WATCH E V ERY DAY

9. NOT MISSING TEXTS 
My husband and I share a car, which 

means he gives me a lot of rides. He 

used to spend a lot of time waiting 

outside my office wondering if I was on 

my way down or if I just hadn’t seen his 

text. Now I see all his texts, and I have 

a happy reply ready to go.

NOW THAT NOBODY calls anymore (which is fine with 

me!), I’m obsessed with getting texts right away. 

10. APPLE TV REMOTE 
I don’t lose my Apple TV remote enough to stick a Tile on it, (go.macworld.

com/tileonremote) although I can’t wait for Apple to release one you can 

“page” from your phone, or dare I say your Apple Watch. (My son did hide it 

in his toy garbage truck once, after all.) But even when I know where my 

Apple TV remote is, sometimes it’s way across the whole entire room, so I 

use the Remote app on my Apple Watch instead. It does everything but the 

Siri and dictation features.

It’s a shame the app didn’t work with the newest Apple TV immediately  

at launch, but it does as of tvOS 9.1, (go.macworld.com/tvOS91) and I use it 

all the time. I hope the forth coming Apple TV app (go.macworld.com/gruber 

appletv) that Eddy Cue announced on John Gruber’s pod cast back in 

Feb ruary has an equally handy Apple Watch component too.
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11. TELLING THE TIME, DUH 
I didn’t wear a watch before I got my Apple 

Watch, not since college. In the year since 

I’ve gotten this watch, I glance at the time on 

it before looking almost anywhere else. On 

days I forget my Apple Watch, I find myself 

looking at my wrist constantly, expecting to 

find out what time it is. It’s a little thing, but I 

forgot how nice it is.

WE ARE BOTH 
SNUGGLED IN HIS BED 
WHEN HE ASKS, AND I 

FORCE-PRESS THE 
WATCH FACE SCREEN 

AND SWITCH FROM MY 
UBER-FUNCTIONAL 
MODULAR FACE TO 

THE BEAUTIFUL 
ASTRONOMY ONE.

12. SPINNING THE PLANETS
My son is 4. When I got my Apple Watch he was 3. He’s pretty good about 

bedtime, but of course there’s a whole ritual of acts he’d like performed in 

a certain order, and one of them—we don’t do it 

every night, but sometimes—is what he calls, “Can I 

spin the planets?”

We are both snuggled in his bed when he asks, 

and I force-press the watch face screen and switch 

from my uber-functional Modular face to the beauti-

ful Astronomy one. He loves it. He loves how a 

green dot lights up on Oakland, where we are, and 

he loves how if you lightly tap the screen, you’re 

able to spin the Earth with your finger, to see how 

it’s daytime on one half and night on the other, with 

little orange glowing spots to indicate big cities. He 

loves twirling the Digital Crown to go forward in 

time, and see the sun and the shadow swoop over 

North America, and the little divot in the West Coast, 

where we are.
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He loves tapping the moon icon and seeing the moon zoom into view, 

the same way it looks in the sky that night. He loves looking at the whole 

solar system, spinning the Digital Crown some more to see the orbits, 

listening to me explain how a year on Mercury is really short and a year on 

Neptune is so long. He says that being 4 is taking a really long time, and I 

try to assure him that every age is exactly the same, even though I know 

that isn’t true. He still thinks the moon is a planet, the biggest planet of all. I 

wonder what questions he’ll ask me about the moon, the world, and the 

universe when he’s 5, or the year after that, or even just next week. It can 

get a little tiring keeping my arm propped up while he fiddles with my 

Apple Watch and we talk about these things. But it’s something I’m really 

glad we can do. ■

FEATURE     A PPLE WATCH E V ERY DAY

ASTRONOMY, aka 

the spin-the-

planets watch face. 
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For more safety tips visit SmokeyBear.com
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WORKING MAC Tips, Tricks, and Tools to Make You 
and Your Mac More Productive

Typing shortcut utilities:  
6 alternatives to TextExpander
If TextExpander’s subscription service rubs you the wrong way, there are 
several options that you can buy—and one that’s free.

BY MICHAEL SIMON
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Even at $45, TextExpander (textex-

pander.com) was one of the most 

essential and popular utilities on the 

Mac (see our review on page 22), but a 

recent change to its pricing structure 

has longtime users feeling scorned. 

Smile made the surprising move to a 

subscription service (go.macworld.

com/textexpander6sub) rather than 

continue its long-standing policy of 

paid upgrades, and even after a 

F
or as long as we’ve been using Macs to type repetitious 
bits of text into emails and documents, there’s been 
TextExpander. One of the original alphabet automators, 
the typing shortcut utility has been at the beck and call of 

writers and coders for generations, dutifully filling in tedious lines 
and phrases, and saving precious seconds throughout our day.

backlash-induced change of heart (go.

macworld.com/tenewprice) that 

lowered the annual rate to $40 for new 

users and $20 for current customers, it 

will still cost something of a premium 

for access to TextExpander’s snippets.

TextExpander might be the most 

popular text-expansion service, but 

it’s certainly not the only one. If 

you’re looking for a cheaper alterna-

tive or just one without such a 

aTEXT
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WORKINGMAC 6 ALTERNATIVES TO TEXTEXPANDER

long-term commitment, check out 

these apps.

aTEXT

aText ($5; trankynam.com/atext) 

might not have TextExpander’s brand 

recognition or breezy interface, but it 

stacks up in just about every other 

way. Calling itself a text accelerator 

rather than an expander, the afford-

able app lives up to its billing, speed-

ing up your typing by offering myriad 

shortcuts for the things you write.

Setting up snippets is as quick as 

using them, and aText gets you started 

with a few common examples. Simple, 

clearly labeled fields will get your 

workflow up and running in seconds, 

storing chunks of text that will expand 

whenever and wherever their accom-

panying abbreviations are typed. 

Dates, images, and formatting can 

also be added to snippets, and handy 

auto-correction tools can help with 

capitalization and misspellings.

Like TextExpander, aText’s greatest 

strength is the time it saves with the 

automation of monotony. The inter-

face is hyper-focused on organiza-

tion, neatly arranging your snippets 

by groups for easy editing. You can 

also create fill-in-the-blank templates 

that can make the most tedious of 

forms a breeze, and if you have more 

than one Mac, Dropbox and Google 

Drive integration will keep your 

snippets synced across all of them.

TYPINATOR

Simplicity and speed are the main 

features of any text expanding app, 

and Typinator (€25; ergonis.com/

products/typinator) has them in 

spades. With easy drag-and-drop 

organization and a powerful set of 

expanding options, Typinator won’t just 

replace your reliance on TextExpander, 

it’ll make the transition effortless.

Unlike most of its peers, Typinator 

is strictly a menu-bar app. But just 

because it doesn’t reside in the Dock 

doesn’t mean it isn’t as full-featured as 

TextExpander. An expansion can be 

as simple as setting tn to expand to 

Typinator, but it can go a whole lot 

TYPINATOR
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deeper than that, with case specifica-

tion, cursor positioning and a whole-

word option that only expands 

phrases when the next typed charac-

ter is neither a letter nor a digit, 

protecting against accidental inserts.

Beyond common text snippets, 

Typinator can be trained to perform 

calculations, or insert the current 

date and time, as well as create 

interactive pop-up boxes for fill-in 

form letters. There are a healthy 

amount of predefined sets, and code 

tinkerers can try their hand at regular 

expressions, which add a unique 

level of power to your snippet library. 

Based on the International Compo-

nents for Unicode, it allows users to 

create complex expansions that are 

triggered under much more specific 

circumstances than a hotkey or 

phrase.

DASH 3

The average 

user can find 

myriad ways to 

save valuable 

time using text 

expanders, but 

for coders they 

can be an 

absolute 

life-saver. 

Cutting down 

on the number 

of times a 

string or variable needs to be typed 

can make or break a deadline, and 

while any of the text expanders here 

can be configured to help, only Dash 

($30; go.macworld.com/dash3itunes) 

makes it its primary mission.

You can use Dash to expand any 

bit of text, but it’s built to speed up 

the coding process by cutting down 

on the thousands of tedious instruc-

tions that need to be written. Even 

before you start adding snippets of 

your own code, the app will speed up 

your programming with an exhaus-

tive catalog of language documenta-

tion that is accessible from the 

sidebar. Fully searchable and cus-

tomizable, it provides an indispens-

able database of rules and refer-

ences that will sharpen your syntax.

Anything you see can be easily 

turned into an expandable snippet by 

copying it and using the Create New 

Snippet From keyboard command. 

DASH 3
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Snippets are sortable by program-

ming language and searchable by 

context, and can be as interactive as 

you need them to be, with cursor 

positioning, date and time stopping, 

and variable placeholders.

TYPEIT4ME

If you’re looking for the original text 

expander, you might be surprised to 

learn it actually isn’t TextExpander. 

TypeIt4Me ($20; ettoresoftware.com/

mac-apps/typeit4me) has been storing 

snippets and expanding text since the 

days of System 6, and it’s every bit as 

useful today as it was back then.

While its interface may have 

changed, its core concept hasn’t. 

TypeIt4Me is just as easy to use as it 

was on the day it was launched, with 

a menu-bar or Dock-based system of 

snippets (or clippings, as they’re 

called within the app) that can quickly 

be added to your document. Com-

pared to TextExpander, TypeIt4Me 

keeps it super simple, with a clear 

input window that mimics the ease of 

an OS X Settings pane.

All of the usual options are here: rich 

text, picture, date, time, autocorrection, 

etc. But the app doesn’t bog you down 

with complicated menus. Snippets are 

given abbreviations for easy expand-

ing, but you don’t actually need to 

remember them. TypeIt4Me’s unique 

menu gives you access to all of your 

clippings, letting you insert them with a 

click rather than a shortcut. Addition-

ally, Ettore offers a TypeIt4Me key-

board for iOS, matching TextExpand-

er’s cross-platform support.

KEYBOARD MAESTRO

Keyboard Maestro ($36; keyboard-

maestro.com/main) won’t just fill all of 

your text expanding needs, it’ll turn 

your keyboard into a veritable 

launchpad that will speed up every-

thing you do on your Mac. But even if 

you just use it for its text expanding 

abilities, longtime TextExpander 

users will appreciate its versatility.

You can use Keyboard Maestro to 

make a basic macro that turns a string 

TYPEIT4ME
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your keyboard into a veritable 

launchpad that will speed up every-
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of letters into a line of text, but expert 

expanders will want to dive into the 

array of options available. From the 

abbreviations to the actions, every-

thing is customizable down to the 

character. For example, when setting 

a snippet to be pasted rather than 

typed, you can tell Keyboard Maestro 

to return the clipboard to its prior 

contents, so whatever you had 

manually copied isn’t wiped out.

Text tokens make macros infinitely 

more powerful by adding fields for 

things like calculations, dates, IP 

addresses, and mouse location, and 

you can also program how your macro 

works within specific apps, or set 

snippets to expire after a set period of 

time. By piggybacking actions, you’ll 

be able to expand your text in pretty 

much any way you can imagine 

whether you’re automating words, 

sentences, or entire pages of type.

SYSTEM PREFERENCES

If you don’t want to pay anything to 

speed up your typing, there’s a way to 

do it right inside System Preferences. 

It’s not as powerful as a stand-alone 

app, but Apple has actually baked text 

expanding abilities into OS X since 

Mountain Lion.

To find it, head over 

to the Keyboard palette 

and click on the Text 

tab. Inside, you’ll be 

able to create basic 

expandable snippets. 

It’s text expansion at its 

most rudimentary, but if 

you’re solely interested 

in saving time while 

typing, it’ll do the trick. ■

YOU CAN CREATE snippets 

in the Keyboard system 

preference.
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5 Gmail hacks that help you 
master your messages
Turn emails into to-dos, tune out distracting conversations, and more with these tips.

BY MICHAEL ANSALDO

WORKINGMAC
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HIT THE ‘MUTE’

Who hasn’t wanted to run screaming 

from their monitor after the thirteenth 

“Welcome aboard!” message to the 

new hire? Gmail provides a means to 

tune out distracting email conversa-

tions like these: muting.

Muted conversations bypass your 

inbox and go straight to your archive. 

They only return to your inbox if a new 

message is addressed solely to you 

or you’re added to the To or Cc line in 

a new message. To silence the noise, 

select the conversation and click the 

GMAIL ALLOWS 

YOU to add other 

email aliases 

and accounts.

A 
while back we looked at several hacks for getting 
more out of your Gmail (go.macworld.com/moregmail) 
account. But as with all of Google’s services, there are 
always more tricks and features to uncover. Here are 

five that will help you better manage your messages.

More button above your messages, 

then select Mute. You can also use 

the keyboard shortcut M.

SEND MESSAGES FROM 

DIFFERENT ADDRESSES

Most of us have multiple email 

accounts: your work address and at 

least one, if not several, personal 

ones. Instead of logging in to each 

account individually, you can send 

messages from any of them through 

Gmail.

You’ll first have to set up your alter-
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nate email 

addresses in Gmail. 

Google provides 

detailed steps (go.

macworld.com/

gmailsendalias) for 

adding external 

addresses and 

domain and email 

aliases. Once they’re added, just 

click the From field when you’re 

composing, forwarding, or replying to 

an email. Then click the drop-down 

menu to the right of the field and 

select the address from which you 

want to send the message.

TURN MESSAGES INTO TASKS

There are dozens of third-party apps 

that let you turn email messages into 

action items. But you can do it with 

Gmail alone thanks to Google Tasks.

Open a message you want to add 

to your to-do list or just select the 

checkbox next to it in your inbox. Click 

More → Add To Tasks or press Shift-T. 

The item will be added to your task 

list in the lower right corner of the 

Gmail window. Click on the task list to 

add a due date and notes, see related 

messages, or move it to another list.

BACK UP YOUR MESSAGES

We all assume our most important 

Gmail messages will be there when 

we need them, but it’s best not to 

tempt fate. As with any other critical 

data, a backup is a must. Google lets 

you do it (go.macworld.com/down-

loadgmailcal) without the need for 

third-party software.

Just go to Google’s data download 

(takeout.google.com/settings/

takeout) page and scroll down to 

Gmail. Click the drop-down menu on 

5 GMAIL HACKS

TO TURN MESSAGES into 

action items, select 

Add To Tasks from the 

More menu.

YOU CAN DOWNLOAD 

your entire Gmail 

data set or just select 

labels.
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the right to download all your mail or 

just particular labels. Messages are 

saved in the widely used .MBOX 

format, so you can easily port them to 

another email service as well.

RECLAIM SPACE

Many of us will never bump up 

against Drive’s 15GB of free storage. 

For those who do, there’s an easy 

way to find the email attachments 

that are hogging the space.

In Gmail’s search bar, type size:xm, 

but replace x with a number (m stands 

for megabytes). This will pull up all 

messages with file attachments over 

the size threshold you’ve designated. 

Save them to your local drive or 

external storage, and then delete them 

from your inbox to free some space. ■
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9 ways to share files  
between Macs
Need to transfer files from one Mac to another? There are many ways to do it.

BY KIRK McELHEARN

WORKINGMAC
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FILE SHARING

The basic way to share files between 

Macs is to use File Sharing. To use this 

feature, you must activate it in the 

Sharing pane of System Prefer-

ences—select File Sharing. If you want 

to only share specific folders, or allow 

certain users to access them, add 

TURN ON File 

Sharing to be 

able to share 

files in the 

Finder.

I
f you have more than one Mac, you probably need to 
exchange files between the two computers from time to time. 
There are lots of ways to do this, and the method you choose 
may depend on the type of file you need to share or the way 

you manage your workflow. Here are 9 ways you can exchange 
files between two Macs.

folders to the Shared Folders list, and 

then select a folder and add users in 

the Users list. If not, any user with an 

account can access your files.

To access another Mac’s files in 

the Finder, choose Go → Network, 

double-click one of the computers or 

devices that displays, and enter your 
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username and 

password. You can 

then browse that 

Mac’s folders and 

files, and drag files 

to and from that 

computer.

AIRDROP

In the Finder, 

choose Go → 

AirDrop on both 

Macs; the one you 

want to send files 

to, and the one 

you’re sending from. Drag a file onto 

the icon of the computer you want to 

send a file to. Unfortunately, AirDrop 

isn’t always reliable, and it does need 

to be active on both Macs, so you 

can’t easily copy files to a server or 

other computer, but it can be easier 

that messing with File Sharing if you 

only need to send files occasionally.

EMAIL

If you have one or more small files 

you need to send to another Mac, 

you can send them as attachments to 

an email message. Just create a new 

message and address it to yourself, 

and then add the files. When you get 

to your other Mac, open your email 

client and download the message 

and its files. This is a good way to 

send files to a Mac that’s not cur-

rently running.

DROPBOX

If you use Dropbox to store some of 

your files in the cloud, it seems 

obvious that you can easily transfer 

files from one Mac to another by 

placing them in your Dropbox folder. 

But you may think that, when you 

need to transfer large files, such as 

videos or large software installers, it 

isn’t practical to put them in the cloud 

and then download them. Dropbox 

has a feature called LAN Sync that 

allows Dropbox to sync them across 

your network to other devices. It still 

uploads them, but if you have a 

bunch of files to transfer from differ-

ent folders, just drop them all in a 

Dropbox folder, and let them sync to 

the other devices. When you’ve got 

the files on the second Mac, move 

them out of your Dropbox folder, so 

they don’t stay in the cloud. Unfortu-

9 WAYS TO SHARE FILES

iCLOUD DRIVE stores 

files for apps, but 

you can also add 

your own files.
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nately, this feature isn’t always 

reliable, so it may not work for you.

iCLOUD DRIVE

Apple’s iCloud Drive is mostly 

designed for apps to store files, but 

you can add files to it as well, which 

you can later access from another 

Mac. Choose Go → iCloud Drive in 

the Finder, and you’ll see a number 

of folders. Just add a file to the top 

level of the iCloud Drive hierarchy or 

create your own folder, and you’ll be 

able to access the file on your other 

Mac. This works best for small files, 

as well as files you may want to 

access on iOS devices.

OTHER CLOUD SERVICES

If you use Google Drive, Box, or 

another cloud repository for your 

files, you can obviously place files 

there from one Mac and access them 

on another. With most of these 

services, you can also upload files via 

a web browser, so you don’t need to 

run their apps if you don’t want to.

BITTORRENT SYNC

One of my favorite ways to sync files 

between my Macs is to use BitTorrent 

Sync (go.macworld.com/bittorrent-

sync2). This free app (with optional pro 

features), lets you sync folders across 

devices. For example, I have a Screen-

shots folder on each of my Macs. 

Whenever I take a new screenshot for 

an article on one of my Macs, it 

instantly syncs across to the other one. 

I also have a folder for current projects, 

which also stays in sync every time I 

add or change a file. I’ve had some 

issues getting folders to sync with one 

of my Macs, but, in general, this 

software works very well, and is 

essentially transparent. It’s the kind of 

YOU CAN USE FTP to 

transfer files to a Mac 

running OS X Server.
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feature that Apple should add to OS X.

FTP

This is a power-user feature, that 

most people won’t need, but some 

might find useful. OS X used to 

include an option to share files via 

File Transfer Protocol, but this is now 

somewhat hidden. To turn on FTP on 

a Mac—more correctly, SFTP, or 

secure FTP—enable Remote Login in 

the Sharing pane of System Prefer-

ences. I use Transmit (go.macworld.

com/transmit4) to transfer files 

between my iMac and my Mac mini 

server, and I find it practical when I 

have a lot of files to copy since I can 

control how many get sent at a time.

SNEAKER NET

Let us not forget that these many 

ways of transferring files from Mac to 

Mac are fine if you have a handful of 

files, but they can take a long time if 

you want to move, say, all seven 

seasons of “West Wing” episodes. 

The best way to transfer very large 

files, or lots of files, is to use sneaker 

net. That’s the term used for copying 

files to a disk, then connecting the 

disk to another computer and 

copying from the disk. You can use a 

USB stick or a portable hard drive, 

and it will always be faster to use 

sneaker net when you have lots of 

large files to move. ■
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— EINSTEIN
  adopted 12-09-10

SURE,
AT FIRST I WAS A LITTLE TAKEN ABACK 

BY THE WHOLE PEEING STANDING UP THING. 
BUT I TAUGHT HIM TO THROW A STICK 

AND NOW HANGING OUT WITH HIM
IS THE BEST PART OF MY DAY. 
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6 ways to transfer files from 
your Mac to your iOS device
Use one of these methods to transfer a file from your Mac to your iPhone, 
iPad, or iPod touch.

BY KIRK McELHEARN

WORKINGMAC
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AIRDROP

AirDrop is Apple’s technology for 

sharing files across devices. You can 

use it to transfer files from one Mac to 

another, and also use it to transfer files 

from a Mac to an iOS device, or from 

one iOS device to another. On your 

Mac, choose Go → AirDrop in the Finder, 

and then, on your iOS device, make 

sure AirDrop is activated in the Control 

Center (swipe up from the bottom of 

the screen to access this setting). You 

can choose to allow transfers from 

Contacts Only or from Everyone; it’s 

best to choose the former.

Your iOS device needs to be awake 

for AirDrop to be active. On the Mac, 

drag a file onto the icon for your iOS 

device in the AirDrop window. On your 

iOS device, you’ll see a menu offering 

to open the file; this menu lists the 

apps that can open the file type.

For some types of files, AirDrop 

isn’t very helpful. For example, if I try 

to send an AAC audio file from my 

Mac to my iPhone, the latter offers to 

CHOOSE WHICH 

APP to open a file 

you receive with 

AirDrop. Here, 

I’ve sent a PDF 

file to my iPhone, 

and all of the 

apps listed here 

can display it.

I
n the preceding story, I wrote about 9 ways you can transfer 
files from one Mac to another, which is useful if you have, say, 
an iMac and a laptop, and need to pass files back and forth. 
But you may also need to transfer files from your Mac to your 

iOS device, which isn’t as simple: iOS isn’t designed to accept just 
any file, and you don’t have the same options to open files with 
different apps. In this article, I’m going to show you 6 ways you can 
move files of various types to your iOS devices.

open it with apps such as Voice 

Memos, Evernote, Dropbox, etc., but 

not with the iOS Music app, or other 

music player apps on my device. So 
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you can’t transfer all types of files 

that your iOS device can use (but 

read on to find out about a way to 

transfer audio and video files).

EMAIL

Using email is a good way to send 

small files to an iOS device. Just 

create a new email addressed to 

yourself and add the file(s) as attach-

ments to the message. Tap the 

attachment in the message to down-

load and then open the file. Depend-

ing on the file type, you may or may 

not be able to open files on your 

device. Naturally, you’ll want to do this 

when you’re on a Wi-Fi network to 

avoid potentially using a lot of cellular 

data if you’re sending large files.

DROPBOX OR OTHER  

CLOUD SERVICES

If you have the Dropbox app on your 

iOS device (or apps for other cloud 

services, such as Google Drive, Box, 

etc.) you can add files to your cloud 

and then access them on your iOS 

device. As with email, you’re limited as 

to which types of files you can open. If 

there are specific files you need to 

access on your iOS device, you may 

need to find apps that can read them. 

For example, if you need to read Excel 

spreadsheets, you’ll need either 

Microsoft Excel for iOS, Apple’s 

Numbers, or another app that can view 

(and perhaps edit) these files.

iCLOUD DRIVE

iCloud Drive is a bit different from the 

other cloud services. It stores files 

that you’ve opened with specific 

apps in dedicated folders. You can 

add a file to iCloud Drive and create 

your own folders, or just copy files to 

the top level of iCloud Drive. To do 

this on your Mac, choose Go → iCloud 

Drive in the Finder, then add the files 

to the location you desire. If you’re 

adding a file that you can open in a 

specific app that already has a 

named folder, you can add it directly 

to that folder. On iOS, either open the 

6 WAYS TO TRANSFER FILES

HERE IS WHAT viewing 

files in the iCloud 

Drive app on an 

iPhone looks like.
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app that can view the file, or open 

the iCloud Drive app, tap the file, and 

then tap the Share button to see your 

options for opening the file.

iTUNES FILE SHARING

Some iOS apps can use iTunes File 

Sharing, a way of adding and manag-

ing files in iTunes so these apps can 

access them. To use iTunes File 

Sharing, connect your iOS device to 

your Mac, select it in iTunes, and then 

click Apps in the sidebar. Scroll down 

to the File Sharing section.

In the example, I’ve added a PDF 

file to GoodNotes. When I click Sync 

at the bottom of the window, iTunes 

will copy that file (as well as copy any 

other items selected to sync, such as 

music, apps, etc.). You can also 

delete files by selecting them in the 

File Sharing dialog and pressing the 

Delete key.

With some apps, you have to click 

+ or Import, and choose to import the 

file(s) from iTunes. This is the case 

even if the files have been copied to 

your iOS device. Other apps may 

show the files immediately.

COPY AUDIO OR VIDEO  

FILES WITH WALTR

Normally, the only way you can copy 

audio or video files to an iOS 

device—at least to be able to play 

them in Apple’s Music or Videos 

app—is by syncing with iTunes. You 

can use iTunes File Sharing to 

transfer this type of file to certain 

apps, such as VLC (go.macworld.

com/vlchandson), for example. 

Softorino’s $30 Waltr (go.macworld.

com/waltr) can copy almost any type 

of audio or video file to an iOS 

device, converting it, if necessary, to 

a format that Apple’s apps can play. 

All you do is connect your iOS 

device, quit iTunes, and then drag 

your file(s) on Waltr’s window. The 

app converts and transfers the files, 

and you can then access them in the 

Music or Videos app. ■

WITH iTUNES FILE 

SHARING, you can 

sync files to your iOS 

device to use with 

specific apps.
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CREATE Using the Web for Video, Graphics, Publishing, 
Photography, and Other Creative Pursuits

10 tips for getting started  
with iMovie for iOS
Splice together your iPhone & iPad videos with slick-looking transitions, add 
titles, lay down custom soundtracks, and more.

BY BEN PATTERSON
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We’ve collected a few pointers that’ll 

help you make sense of iMovie’s (go.

macworld.com/imovie) overall 

workflow. We’ll also decipher the 

app’s simple (if occasionally head-

scratching) interface as well as try 

out some basic editing tools. With a 

little practice, you’ll be splicing 

together video like a pro in no time.

GETTING STARTED

The first step to making a movie in 

iMovie is getting a hang of the overall 

process—and for that, it’s best to 

understand the three main tabs of 

the iMovie app: Video, Projects, and 

Theater.

The first tab, Video, displays all the 

video clips stored on your iOS device 

or in iCloud. Think of the Video tab as 

your warehouse of raw video clips.

The next tab, Projects, is where 

you’ll be doing all the work. To make 

a movie, you’ll need to create a 

project, stir in some clips from the 

Video tab, and then start editing.

THE PROJECTS TAB 

in iMovie is where 

you’ll do most of your 

editing; the Video tab 

is where you’ll find 

videos to edit; and the 

Theater tab is where 

you’ll go to export 

your finished movies.

Y
our iPhone videos don’t have to be boring just 
because you shot them with iOS. With a little help 
from Apple’s iMovie, you can add quite a bit of polish 
to your clips, spiffing them up with titles, transitions, 

slow and fast motion, and even background music. (Note: iMovie 
is available as a free download for all iOS devices purchased 
since September 2013; for everyone else, it’s a $5 download.)
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The last tab, Theater, is where your 

projects will go once they’re fully 

baked. Once you’ve “exported” a 

project to the Theater tab (aka, 

“iMovie Theater”), you’ll be able to 

play your new movie on all your 

iCloud-connected devices, stream it 

to an Apple TV, or even upload it to 

YouTube.

CREATE A NEW PROJECT & 

PICK A THEME

Now that you have a general idea of 

how to make a movie in iMovie, go to 

the Projects tab and tap the big + (plus 

sign) button to create a new project.

You’ll be presented with two 

choices: make a movie, or create a 

trailer. Let’s stick with the Movie option 

for now. (Making a trailer involves 

collecting a just-right sequence of 

action shots, profiles, landscapes, 

two-shots, and more, so it’s more 

complicated than it may seem.)

Next, you’ll be asked to pick a 

theme, anything from Modern and 

Bright to News and even CNN 

iReport. Each theme comes with its 

own title design, transitions, and 

(optional) background music. For this 

example, I selected the Simple 

theme, but it can easily be changed 

later. Once a theme is selected, tap 

Create. 

ADD SOME VIDEO CLIPS

Once you’ve created a project, you’ll 

jump right into the My Movie inter-

face. Tap the Media button (the one 

that looks like a film strip) and tap the 

Video tab. (If you’re using iMovie on 

your iPad, the Media window will 

already be sitting in the top corner of 

the My Movie screen.)

Next, tap a clip, then tap the curved 

arrow—when you do, the clip will fly 

10 TIPS TO GET STARTED WITH iMOVIE FOR iOSCREATE

PICK A THEME for your 

movie, anything 

from Modern to CNN 

iReport—and yes, you 

can always change 

the theme later.
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into the My Movie interface. Go ahead 

and tap the Media button again, then 

add one more clip to the mix.

Back on the My Movie screen, tap 

the Play button to watch your two 

video clips cut together, complete 

with a dissolve transition between 

them. In the bottom half of the 

screen, try dragging your new movie 

back and forth with your fingertip; the 

vertical line in the middle of the 

display shows the exact point in the 

clip that’s being displayed in the 

preview area above.

Bonus tip: You can add still photos 

to your video, too—just pick them from 

the Media tab. You’ll be able to trim 

your still just as you would a video clip.

TRIM YOUR CLIPS AND 

CHANGE THE TRANSITION

Now, let’s do a little snipping. Tap the 

first clip in the lower editing section; 

when you do, it’ll be outlined in 

yellow. Go to the beginning or the 

end of the clip, tap and hold the thick 

yellow side, then drag to snip out a 

portion of the clip. (Don’t worry, 

you’re not trimming the original 

video.) If you want to trim the second 

clip in your project, go ahead and 

repeat the process.

Now, see the little square with the 

bow tie between your two clips? 

That’s your transition. Tap it, and 

you’ll see a series of transition styles 

at the bottom of the screen, including 

TAP THE CURVED arrow 

to add a video to your 

iMovie project.
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Dissolve, Slide, Wipe, and Fade. Tap 

one and press Play to see how each 

transition looks; you can also pick the 

None option for a “hard” cut. 

What’s the Theme transition, you 

ask? It’s a transition that’s styled after 

the theme you picked when you first 

started your project; for example, 

Modern will give you a smooth, 

“swoosh”-type theme, while the 

News transition features a digital 

globe that flies up the screen, not 

unlike something you’d see on World 

News Tonight.

And by the way: To change your 

theme, tap the Settings button (the 

one that looks like a gear), and then 

pick a new theme from the list.

Bonus tip: To add fade-in/out 

effects to the beginning and end of 

your iMovie, tap Settings, then flip 

the switches next to Fade In From 

Black and Fade Out From Black.

ADD SOME TITLES

What would a movie be without 

opening titles? Tap the first clip in your 

project to select it, then tap the Titles 

button (T) at the bottom of the screen.

Next, pick a style from the choices 

at the bottom of the screen—any-

thing from Standard to Pop-Up. You 

can also pick a style based on one of 

the movie themes we mentioned 

earlier; to do so, just tap the button 

next to the None button. 

10 TIPS TO GET STARTED WITH iMOVIE FOR iOSCREATE

AMONG THE 

TRANSITIONS 

from which you 

can choose: 

Dissolve, Slide, 

Wipe, and Fade.
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Once you’ve settled on a style, tap 

a title in the preview window, then 

type in whatever title you like—such 

as Claire�s 4th birthday party, 

for example. Depending on the style 

you picked, there may be multiple 

titles to fill in.

SPLIT YOUR VIDEO CLIPS

You may have noticed that the titles 

you just added to your video clip are 

staying on the screen for the entire 

length of the clip you selected. That’s 

not exactly desirable if, say, the 

selected clip is five minutes long.

Here’s how to fix it—and indeed, 

this is a trick you’ll be using for many 

different iMovie effects.

Move the clip with your fingertip 

until about four or five seconds have 

elapsed in the preview window, then 

tap the clip to select it. Next, tap the 

Edit button (the one that looks like a 

pair of scissors) at the bottom of the 

screen, then tap Split.

TAP A FIELD and start 

typing to customize 

your titles. 

JUST SELECT A video 

clip and tap Split to 

divide one of your 

clips in two.  
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Now, play back the entire clip, and 

the titles will disappear at the precise 

moment where you split the clip.

TINKER WITH THE 

SOUNDTRACK

There’s nothing that sets the mood 

like some music. iMovie allows you to 

add in background tunes, sound 

effects, and even a little color com-

mentary to your movie.

To do so, move your first video clip 

to the very beginning, tap the Media 

button, tap the Audio tab, then select 

Theme Music. Choose a track—like 

Bright, for instance—then tap the 

curved arrow to add it to the 

editing bay.

Go ahead and tap Play, and you’ll 

hear a peppy music track to go along 

with your video.

Naturally, you can edit the audio 

track just as you can your video clips. 

Tap the green music track to select it, 

tap the Edit button, then tap Split. Tap 

the newly created second segment of 

the track, then tap Edit → Delete. Now 

tap the remaining audio track, tap the 

Volume button at the bottom of the 

screen, then adjust the slider to 

change the track’s volume. Or, try this: 

tap Volume → Fade, then tap and drag 

one of the yellow triangles to make 

the track’s volume fade in or out.

You can also add your own com-

mentary to the video by tapping the 

microphone button. Tap Record, start 

chattering, and tap Accept when 

10 TIPS TO GET STARTED WITH iMOVIE FOR iOSCREATE

JUST GRAB ONE of the 

yellow arrows and 

drag to make the 

audio track fade in 

or out.
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you’re happy with the recording. You 

can then tap the new recording track 

to edit it, just like you did with the 

green music track.

Also on deck in the Media screen: 

sound effects (tap the Media button, 

then Audio → Sound Effects), as well as 

songs on your iPhone or iPad.

Last but not least, you can tweak the 

audio track of one of the video clips in 

your project. Tap the clip to select it, 

tap the Edit button at the bottom of the 

screen (if it isn’t already selected), then 

tap Detach. When you do, the sound 

for the clip will jump into its own audio 

track, which you can edit, trim, fade, or 

adjust its volume.

ADD A VIDEO FILTER

If you want your video—either the 

whole thing, or just a portion—to look 

like a vintage movie, complete with 

film scratches and other nifty effects, 

just add the correct video filter.

Tap a clip to select it, tap the Filter 

button (the one that looks like three 

shaded circles), then pick a filter—

anything from Blast and Blockbuster 

to Silent Era or Vintage.

If you only want a portion of a clip to 

have a color filter, just split the clip and 

add the filter to the segment you want.

SPEED UP (OR SLOW DOWN) 

YOUR VIDEO

You can add fast- or slow-motion 

effects to your movies in just a few 

taps. Say, for example, you want to 

speed up a sluggish scene. Just 

create a segment of a clip with the 

Edit tool, tap the segment to select it, 

tap the Speed button (the one that 

WANT YOUR VIDEO to look like a silent movie? Just pick the Silent Era video filter.
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10 TIPS TO GET STARTED WITH iMOVIE FOR iOSCREATE

looks like a speed gauge), and then 

drag the slider right to speed up the 

clip, or left to slow it down.

Bonus tip: To make the sped-up (or 

slowed-down) segment more dramatic, 

grab a “whoosh”-like sound effect from 

the Media window (Jet Fly By works 

quite nicely), drag it beneath the 

segment, then edit it down to fit.

EXPORT AND SHARE YOUR 

NEW MOVIE

There are still plenty of handy iMovie 

tricks for you to discover; for starters, 

we haven’t covered how to create a 

split-screen scene, how to zoom a 

video, or how to splice in a freeze-

frame. By now, though, you know 

enough to make a reasonably 

slick-looking iMovie, and it’s time to 

show it off.

The first step is to export your 

video to iMovie Theater, a repository 

for all your completed iMovie projects. 

When you’re ready to export your 

movie, just tap Done from the My 

Movie editing screen. Next, tap the 

Action button (the square one with the 

arrow), then tap iMovie Theater.

The iMovie app will then begin 

exporting your video, a process that’ll 

take from a few seconds to several 

TO SPEED UP or slow 

down a video clip in 

your project, select 

it and tap the Speed 

button.
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minutes, depending on the length of 

your movie and the age of your iOS 

device. (Older iPhones and iPads take 

longer to process video files.)

Once that’s done, your movie will 

appear under the Theater tab, and 

it’ll automatically sync with your other 

iCloud-connected devices. Tap on a 

movie and tap the Action button to 

send the movie via Mail or Messages, 

post it to Facebook or Twitter, upload 

it to YouTube, and more.

Still want to edit the movie? If so, 

you’ll have to go back to the Projects 

tab, open the project you want to 

edit, and then re-export it to the 

Theater tab once you’re finished. ■
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A little bit of easy math is all it takes to make sure your prints look their best.

BY LESA SNIDER

The secret to producing 
subtle photographic color 
effects in Photoshop
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These ageless and classy tech-

niques limit the photo’s color pal-

ette, which puts focus on the image 

content. Similarly, cross processed 

looks are wildly popular, though with 

this effect you keep the image’s 

color yet shift it in interesting ways 

(the term refers to dark room days 

where the color shift was produced 

by processing the image using the 

wrong chemicals).

While crafting these effects 

HERE YOU SEE the full-

color image and the 

color chips at the 

bottom of Photoshop’s 

Tools panel.

C
olor trends come and go, though when it comes to 
photographic treatments, some color effects are here 
to stay. For example, adding a brown tint to a black 
and white image produces a sepia tone that evokes a 

vintage or romantic feel. Likewise, adding pastel pink or blue—
Pantone’s colors of the year are rose quartz (13-1520) and serenity 
(15-3919)—to a black and white image evokes a soft, dreamy feel. 

yourself can feel daunting, it doesn’t 

have to. As luck would have it, 

Photoshop CS6 and later include 38 

photographic toning presets that you 

can apply as a gradient to produce 

subtle yet gorgeous color tints. The 

trick is knowing where to find them. 

And since you get slightly different 

results when using the toning presets 

on a black-and-white image versus 

one that’s full color, this column takes 

a look at both.
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TONING A BLACK-AND- 

WHITE IMAGE

The first step is to open an image 

and then convert it to black and 

white. There are many ways to do 

this: you could do it in the Camera 

Raw plug-in or filter, you can do it in 

Lightroom and then pass the image 

off to Photoshop, or you can use a 

Black & White adjustment layer (the 

latter method sports a Tint option 

that lets you apply one color to an 

image, but not the gradients we’re 

seeking here), etc. We’ll use my 

favorite method: a Gradient Map 

adjustment layer (which also hap-

pens to be where those toning 

presets live). Because this adjust-

ment layer uses the foreground and 

background color chips, press the D 

key on your keyboard to set them to 

their default values of black and 

white and then tap the X key to 

flip-flop them so black is on top and 

white is on the bottom.

Next, click the half-black/half-white 

circle at the bottom of the Layers 

panel and choose Gradient Map. The 

Properties panel springs open and 

Photoshop maps image shadows to 

the first color in the gradient (your 

foreground color chip, which is 

black), highlights to the second color 

(your background color chip, which is 

white), and midtones to all the 

shades of gray in between. (This part 

works in most versions of Photoshop 

Elements, too.)

AS YOU CAN see 

here, a Gradient 

Map adjustment 

layer can create 

awesome black-

and-white 

images.
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Now let’s add a toning preset. With 

the Gradient map adjustment layer 

active, duplicate it by pressing 

Command-J. With the duplicate layer 

active, trot over to the Properties 

panel and click the down-pointing 

triangle to the right of the gradient 

preview. From the menu that opens, 

HERE THE Copper 2 preset was applied at 50 percent 

opacity.

click the tiny gear icon and then 

choose Photographic Toning. Click 

on Append in the dialog box that 

opens and the new presets appear 

last in the list. The rest is easy: single-

click each preset until you find one 

you like. Use the Opacity setting at 

the top of the Layers panel to control 
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the strength of the tint.

It’s worth noting that this method 

doesn’t produce a true grayscale 

image. If you peek into Photoshop’s 

Channels panel, you still see red, 

green, and blue channels. This is 

really only important if the image is 

headed to an offset printing press 

wherein the cost of printing can be 

lowered by reducing the number of 

colors in the image. To produce a 

true grayscale image, you must 

change the document’s mode to 

Grayscale. Once you do that, you 

gain access to Duotone mode where 

even more toning presets live (great 

fodder for a future column).

TONING A COLOR IMAGE

To shift the colors in your image 

without going black-and-white first, 

you need one Gradient Map adjust-

ment layer and it doesn’t matter 

what colors your foreground and 

background color chips are set to. 

So add a Gradient Map adjustment 

layer and, if you haven’t done so 

already, load the Photographic 

Toning presets as described above. 

Click the preset you want to use and 

then adjust layer opacity until you’re 

happy with the effect.

As long as you save the file in 

Photoshop format, you can play with 

other toning presets anytime you 

want by double-clicking the Gradient 

Map adjustment layer’s thumbnail to 

reopen the Properties panel. You can 

also experiment with changing the 

Gradient Map adjustment layer’s 

blend mode, and opening the 

Gradient Editor to customize the 

presets—the creative possibilities are 

endless. ■

PHOTOGRAPHIC COLOR EFFECTS IN PHOTOSHOPCREATE

YOU CAN HIDE the 

black-and-white 

effect by turning off 

the layer visibility 

(circled) of the 

first Gradient Map 

adjustment layer.
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Up your typography game in Apple, Microsoft, Adobe, and Quark apps.

BY LESA SNIDER

How to access advanced 
OpenType features in a 
variety of apps
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In this column, you’ll learn to use a 

variety of applications to add a 

special flourish to an important letter 

in a word—say, the first or last letter 

of a name—or to change the appear-

ance of any amount of text. It’s a 

wonderful way to enliven an invita-

tion, greeting card, inspirational 

graphic, logo, headline, stationery, 

resume, and so on.

ABOUT OPENTYPE FONTS

Released in 2000, the OpenType font 

format was intended to replace 

TrueType and PostScript font formats, 

and it dramatically extended the 

potential scope and intelligence of 

fonts. Soon font developers began 

releasing advanced OpenType 

fonts—most have Pro in their name—

that contain thousands of characters 

(correctly called glyphs).

Over the years, creative and 

ambitious font developers added 

multiple versions of some charac-

ters—say, different versions of an 

F—enabling you to customize text in 

special ways. That said, however 

fun replacing one character with an 

alternate glyph can be, it gets 

F
ancy typography doesn’t require expensive software. 
Thanks to the OpenType font format, the newest ver-
sions of everyday software (and the pro stuff) can tap 
into a multitude of alternate character designs if you 

know where to look.

tedious because advanced Open-

Type fonts often include lots of 

alternates for some characters and 

zilch for others. Also, some alter-

nates simply don’t look good when 

placed next to specific other char-

acters.

To aid you in locating alternate 

characters that look good together, 

some advanced OpenType fonts 

include stylistic sets, specific combi-

nations of alternate characters 

chosen by the font designer. Some 

fonts also include more typographic 

substitutions in the form of addi-

tional alternate glyph sets named 

contextual alternates, swash alter-

nates, and titling alternates. Initially, 

you needed pro-level software to 

access advanced OpenType fea-

tures but not anymore.

To swap glyphs, you have to start 

with an advanced OpenType font so 

the biggest challenge may be 

figuring out which of your installed 

fonts qualify. If you bought the font, 

then you’ll know; however, some are 

automatically installed with Adobe 

applications. If your Mac has a font 

with Pro in its name, it’s probably an 
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advanced OpenType font (in Adobe 

apps, you can find them by entering 

“pro” into the font name field). If you 

don’t have any, you can buy them 

from Adobe (go.macworld.com/

adobetype), FontShop (fontshop.

com), P22 Type Foundry (p22.com), 

Sudtipos (the maker of your author’s 

favorite, Adios Script Pro, sudtipos.

com), and other font developers. If 

you subscribe to Adobe’s Creative 

Cloud, you have free access to 

advanced OpenType fonts through 

TypeKit. However, to try out the 

NOTE THE 

DIFFERENCE 

between the 

H and the L 

using regular 

Bickham Script 

Pro (top) vs. the 

fancier versions 

using glyphs 

in Alternate 2 

(bottom).
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features in this column without 

spending money, download Gabriola, 

a free advanced OpenType font from 

TheFonty.com.

ACCESSING ADVANCED 

OPENTYPE FEATURES

The way you access advanced 

OpenType features depends on the 

application. However, the first step is 

to highlight some text and then apply 

an advanced OpenType font to it. 

Next, highlight the character(s) or 

word(s) that you want to swap for 

something else.

USING APPLE APPLICATIONS

In Apple applications (TextEdit, 

Pages, Keynote, iBooks Author, etc.) 

choose Format → Font → Show Fonts 

or press Command-T. Click the gear 

menu (circled in the screenshot on 

the previous page) and choose 

Typography. In the resulting panel, 

click the triangle next to the Alter-

nates section and then turn on any of 

the alternates in the list to change 

the highlighted text. If the font also 

includes stylistic sets (not all of them 

do), you’ll see a section named 

Alternative Stylistic Sets. If it includes 

contextual alternates, there’ll be a 

section for that, too (the latter also 

includes swash alternates that can 

add some seriously ornamental 

swashes to your text).

UNFORTUNATELY, WORD doesn’t indicate which sets are available for your font, 

so you have to try them all to find one that works. Adios Script Pro was used 

here; notice the difference in the a and r in set 6.
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USING MICROSOFT WORD

You can’t access alternate glyphs in 

Microsoft Word, but you can access 

stylistic sets and contextual alter-

nates in Word 2010 and higher. To do 

that, choose Format → Font and, in 

the dialog box that opens, click 

Advanced and then click the Stylistic 

Sets menu. The switch for contextual 

alternates lies beneath that menu.

USING ADOBE INDESIGN, 

ILLUSTRATOR, AND 

PHOTOSHOP

To access alternate glyphs in Adobe 

InDesign or Illustrator, choose 

Window → Type & Tables → Glyphs; in 

Photoshop, choose Window → 

Glyphs. In the panel that opens, click 

the Show menu and choose Alter-

nates For Selection. Double-click an 

alternate’s thumbnail to swap them 

out.

To access stylistic sets in InDesign, 

choose Window → Type & Tables → 

Character. Click the fly-out menu at 

the panel’s upper right, choose 

OpenType → Stylistic Sets, and then 

pick one of the non-bracketed sets 

(those with brackets aren’t available 

in the current font). To apply a 

different set, deselect the first one 

and then pick a different one (a 

frustratingly tedious procedure)—you 

can apply multiple stylistic sets, 

sometimes a character or two will 

change but sometimes not. InDe-

sign’s OpenType menu also provides 

options for swash, contextual alter-

nates, and titling alternates. In Adobe 

applications, enabling each alternate 

individually provides different 

combinations of characters, as does 

enabling more than one at the same 

time.

Photoshop and Illustrator lack 

stylistic sets, but they have contex-

tual, stylistic, and titling alternates, 

which are worth exploring. To find 

them in Photoshop, choose Window 

→ Character, click the panel’s fly-out 

menu, and choose OpenType to 

reveal a list of options. In Illustrator, 

choose Window → Type → OpenType 

and then click the panel’s fly-out 

menu to get a list.

ACCESS ADVANCED OPENTYPE FEATURESCREATE

HERE YOU CAN SEE the 

alternate glyphs for an 

F in Adios Script Pro in 

InDesign.
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USING QUARKXPRESS

To access alternate glyphs in QuarkX-

Press, choose Window → Glyphs. In 

the panel that opens, choose Alter-

nates For Selection from the second 

menu from the top. Stylistic sets aren’t 

available yet, but they will be in 

QuarkXPress 2016 (set to release in 

the second quarter of 2016). You’ll be 

able to find them in the Character tab 

of the Measurements palette—click 

the green O to see them.

As you can see, advanced OpenType 

font features can set your text apart 

from all the rest. Until next time, may the 

creative force be with you all! ■

CONTEXTUAL ALTERNATES are worth exploring, as 

you can see in this before (top) and after (bottom) 

in Photoshop. The flourish in the lowercase p 

greatly improves the ad.
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HELP DESK Answering Your Questions and Sharing Your 
Tips About Getting the Most From Your Mac

Mac 911
Solutions to your most vexing Mac problems.

BY GLENN FLEISHMAN

What happens when you can’t control the album sort 
order in Photos when synced 

 Q: I just edited my albums on my Mac. The photos are in a specific order in 

certain albums, but this hasn’t synced to the iPhone or iPad. The photos are 

still in random order on those two devices. 

— Simone Nixon

 A: I haven’t been able to replicate this: All photos in my albums (tested under 

iOS 9.3 and OS X 10.11 El Capitan) retain their order synced using iCloud Photo 

Library. It’s possible there’s corrupt data. You can repair the library by quitting 

PHOTOGRAPH COURTESY OF APPLE
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Photos, then holding down the 

Command and Option keys while 

launching Photos. You’ll be prompted 

to repair. This can take a while for 

libraries with thousands of images. 

Because you intentionally re-

ordered images, you shouldn’t be 

affected by a sorting option you can 

enable, because manual changes 

override the option. With an album 

selected, you can select View → Sort 

and choose one of the “keep” items 

that locks image sorting by a particu-

lar criteria. That can be by oldest first, 

newest first, or the photo’s title. 

 Some people also see a related 

issue: The order into which they sort 

their albums in Photos on one device 

doesn’t sync and isn’t retained to oth-

ers. I tested this in my setup, and 

found that all albums remained in the 

same sort order and that changing 

the order in one place was almost 

instantly propagated to another 

device. If this stops working, how-

ever, I haven’t seen any solution to 

set it right. 

How to stop OS X from 
deleting trashed files 
immediately
Lana Y. writes in with a problem 

related to getting rid of files in OS X. 

Like many people, she wants to use 

Trash as a way station and then opt 

to empty trash later.

Q: My files are deleted immediately, 

without possibility to access them 

in Trash. I tried to change the 

YOU CAN LOCK the 

order of photos sorted 

within an album.
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THE UNDERLYING UNIX 
DIRECTORY FOR FILES 
EN ROUTE TO DELETION 
ISN’T GLOBAL BUT IS 
LOCATED IN EACH USER’S 
HOME DIRECTORY.  

MAC 911HELP DESK

mounted file servers, too, for the 

same reason.) 

You can solve this via the Terminal 

although you need to be even more 

careful than usual in entering a 

command there, as you could delete 

other files if you don’t copy and 

paste (or, type in) the exact 

sequence—it won’t just fail, but could 

delete parts of 

your drive.

With that 

warning in 

place, follow 

these steps 

when logged 

into your 

account, which 

has to have administrative privileges 

for this to work: 

1. Launch Application → Terminal.

2. At the command prompt, type 

(or, preferably, copy and paste):  

sudo rm -ri ~/.Trash

3. Press return. 

4. You should first be prompted for 

your account’s password; enter it, 

and press return. 

5. You should next be prompted to 

remove any files and folders in the 

.Trash folder, followed by the 

.Trash folder itself. Type yes and 

return at each prompt. (This is a great 

place to notice if you’ve entered 

anything incorrectly above, too, and 

to press Control-C to halt the removal 

if you have.)

privileges and tried to find Trash in 

terminal. Nothing helps.

— Lana Y. 

A: This is a common and frustrating 

problem, and Lana isn’t alone. The 

file permissions associated with trash 

are out of whack, making it impos-

sible for OS X to write new files to 

the Trash folder, 

and OS X 

doesn’t have a 

friendly way to 

repair it, even 

though your 

Mac knows 

enough that it 

can’t write to 

the folder! (OS X could note the 

problem and ask a user, “There’s 

something wrong with your Trash, 

which prevents files from being put 

there. Would you like to repair it?” as 

one possibility. OS X notices similar 

other problems.)

The underlying Unix directory for 

files en route to deletion isn’t global 

but is located in each user’s home 

directory. This is transparent to you 

when using OS X unless the permis-

sions for the directory become 

messed up. In that case, because OS 

X can’t move the items you want to 

delete into this temporary location, 

you’re prompted to delete files or 

folders immediately. (You’ll see this 

warning when deleting files from 
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6. Log out of your OS X account 

(Apple menu → Log Out Username, 

which closes all programs) and log 

back in. The problem should be 

solved, as OS X will create a new 

.Trash folder with the correct 

permissions.

 (If you like to live dangerously, use 

sudo rm -rf ~/.Trash instead to 

bypass being prompted to delete 

each file or folder. But I warned you.)

 If you continue to have problems, 

you may have permissions problems 

on mounted drives. You can repeat 

the above operation for each volume, 

which contains a hidden top-level 

.Trashes folder with separate 

folders for each user in OS X.

 In step 3, instead of ~/.Trash, 

you use each volume’s name. In OS 

X, you can type df -H to find the 

names of each volume, which are 

listed under a Mounted On column in 

form /Volumes/ plus the drive’s 

name.

 Unix doesn’t recognize spaces in 

names as part of the name unless 

they’re handled carefully, by putting a 

backslash in front of them, such as  

/Volumes/My\ Main\ Backup\ 

Drive. You can avoid having to do 

this formatting by dragging the 

volume in question into the Terminal 

window after entering the command 

for step 2:

> Type sudo rm -ri plus a space.

> Drag the volume onto the 

Terminal window, and it inserts the 

properly formatted volume name. 

> Now press Delete to remove a 

space after the drive’s 

name that’s automatically 

inserted, and add 

/.Trashes. 

Now log out of your 

account and back in, and 

you should have your Trash 

folder restored to normal. (If 

you’d like to be able to 

delete immediately, see go.

macworld.com/deletefrmtrash on 

using that function intentionally.)

How to sort files and 
folders in the Finder

Q: I have several folders in the 

Finder, but I can find no way of 

keeping them in alphabetical order. 

They move according to when they 

were last accessed, which, for my 

work, is confusing.

— Emily O’Brien

A: I say folks are scared to ask, 

because it’s the kind of thing that 

seems like a novice question (which 

Emily isn’t, given her expert use of the 

term Finder), but it opens up the fact 

that every person uses the same 

operating system differently. Even 

something like sorting items isn’t 

perfectly exposed.

 It’s possible something is broken 

http://www.softgozar.com


148

in the Finder causing a 

sort problem; we 

should never discount 

that. But assuming all is 

well, you can sort items 

in a Finder window 

alphabetically by: 

 > Clicking the Name field at the 

top of the list view. An upward-point-

ing arrow following Name indicates 

sorting alphabetically with numbers 

first, then A to Z; click again to swap 

to downwards, and it’s sorted Z to A, 

then reverse numeric order. 

 > Select the menu item View → 

Arrange By → Name. 

> Click the Arrange By/Sort By icon 

in the Finder window toolbar (if that 

icon is displayed) and choose Name. 

You can also experiment with 

Arrange By, which groups items into 

larger categories, coupled with Sort By. 

In a downloads folder, for instance, I 

have Sort By set to descending 

chronology (oldest files first) using Date 

Added, and then 

Arrange By Set to Name. 

This groups items into 

Today, Yesterday, 

Previous 7 Days, 

Previous 30 Days, and 

months and years after 

that (as long as any items fit into each 

date group). Within each group, the 

items are alphabetized to make them 

easier to read through. ■

MAC 911HELP DESK

Ask Mac 911
We’re always looking for problems 

to solve! Email us at mac911@

macworld.com including screen 

captures as appropriate. 

Mac 911 can’t provide direct email 

responses or answers for every 

question. For that, turn to Apple-

Care, an Apple Store Genius Bar, or 

the Apple Support Communities.
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